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Installing
I'm sure you are keen to get started so you'll be pleased to know that the installation process is very
simple. Simply download the installer from the Resolume website, run the install file and follow the
instructions.

The website will detect whether you're on a Mac or PC and offer you the correct download for your
system. Are you using a PC and do you need Resolume for Mac? No worries. Just scroll down to the
dropdown at the bottom of the page.

Because of the graphical acceleration that is used, Resolume does have some system
requirements. Please check the spec page for the current minimum requirements.

http://www.resolume.com/download


Quickstart Tutorial
Right!  You've got Resolume installed so let's jump in and see what it can do, shall we?

Run the Resolume application. The Resolume interface will appear. It may look complicated at first
but don't worry - it will soon all make sense.

A new Resolume install comes with a demo composition. A composition is what we call a complete
Resolume setup - each composition can include sets of clips, preprogrammed effects and all other
settings that you need for a performance.

Trigger Clips
Below the menu bar, you should see a set of horizontal rows that each have some controls on the
left and a set of thumbnails. Each thumbnail is a different clip.

Go ahead and click one of the thumbnails now. The clip will start playing. Note that these clips are
set up to be synchronised to the BPM (Beats Per Minute) setting, so the clip may not start playing
instantly - it will wait for the start of the next bar. Don't worry, if you want to launch clips instantly,
you can set them up to do that.

But first things first. You should now see the clip playing in the output window on the left and hear
the audio of the clip. Awesome. You're VJ'ing.

You can take control of the clip that is playing by clicking the Clip tab. The Transport section of this
tab is the bit we are interested in for now.

You can use the Forwards, Backwards and Pause icons to start and stop the clip. You can also grab
the moving blue wedge directly to scratch the clip - wikka wikka wah!

Note that messing with the clip like this will mean that it is no longer synchronised with the BPM -
the tempo will be right but it will be out of phase. You can resynchronise it by clicking the clip



thumbnail again - it will start again at the start of the next bar.

Mixing
Playing one clip is all very well but mixing clips together is where the fun really starts.

Each of the horizontal rows of clips is a separate layer. Each layer can play one clip at a time. Try
clicking another thumbnail on the same layer as the one that is already playing. You will see that, at
the start of the next bar, the output will change to play the new clip.

Now try clicking a clip from a different layer. This time, the old clip will continue playing and the new
clip will be mixed with it.

Have a look over to the left of the thumbnails. There
are two vertical sliders marked 'A' and 'V'. Try sliding
these up and down on the layers that you have
playing. Logically enough, the 'A' slider fades the audio
of the layer in and out. The 'V' slider does the same for
video. You can also use the 'M' (master) slider to

control both at the same time.

Effects
So we've got some clips playing. Let's mess with them using some effects. Over on the right hand
side of the interface are some tabs that say 'Files', 'Compositions', 'Effects' and 'Sources'. Select the
Effects tab.

Below the tab will now be a list of effects. These are the video effects that are included with
Resolume.



Pick an effect. Any effect will do, but I
recommend Bendoscope as a good one to
start with. Now drag it over to the left
where there is a tab called Composition.
As you get over there, drop the effect in
the area where it says 'Drop effect or mask
here'. You'll know when you're in the right
place when you see four colored corners
appear around the Composition tab.

You should immediately see that the output video has been distorted by the effect. Such trippy. 

Now look back to the place where you dropped the effect in. You will see that there are two sliders
under the Bendoscope effect.

All video effects have the Opacity slider - it is used to mix the effected video with the original.

Most effects also have
additional parameters that
you can control. Bendoscope
has one - the number of
divisions used in its
distortion effect. Try sliding
this slider to the left and

right to see what effect it has on the output video. More such trippy.

You can add more effects by dragging them over from the Effects tab. Each effect takes the output
of the one before it and effects it, so you can combine many effects to make something beautiful.
Or a great big mess.

If you want to get rid of an effect, just click the x to the right of the Effect's name. 

Have a Play!
Now is a good time to have a play with Resolume. Play some clips, add some effects. See what
happens. Most of all, have fun!



A useful feature is the help window in the
bottom right of the interface. This will
show some brief hints about how to use
whatever the mouse pointer is currently
over.

In the other sections of the manual, we will be looking in detail at all of the features of Resolume, so
if you come across anything that interests you, you will be able to find out how to use it.



Basic Vocabulary
Let's get some basic Resolume terminology out of the way. This way we can understand each other
better when we get into the nitty gritty of how Resolume works. Don't worry, I promise I'll keep it
simple.

Clip

A Clip can consist of a video file or a still image, an audio file, or a combination of those. It could
also contain a Source, like a live camera input. The clip also has many settings that change how the
clip is played and how it looks and sounds.

Layer

Each clip sits in a specific Layer. Only one clip from each layer can play at a time. Layers can be
blended together to create the final output.

Group
Layers can be combined into Groups. Groups are little sub compositions, where multiple layers are
composited together and can be controlled with a single fader. Groups are available on Arena only.

Composition



A Composition is a complete Resolume setup with sets of clips, assigned effects, parameter settings
and control shortcuts. Switching compositions takes some time, so youâ��ll want to prepare a
complete performance as a single composition.

Deck
The clips in a composition are divided into Decks for easy access to the clips that you want, when
you want them. Switching decks is quick and does not interrupt playback, so you can switch
between decks while performing.

Effect
Effects can be added to the whole composition, a specific layer, a specific group, or a single clip.
They change how the output looks or sounds. They're lots of fun and when used wisely, they can be
your greatest asset.

Parameter
Parameters are used to control everything in Resolume. Everything that can be adjusted, is
adjusted with parameters. A clip has several parameters like playback speed and playback
direction, a layer has parameters like scale and blend mode, and effects can have loads of different
parameters. You use parameters to fine tune your composition.

Shortcut
MIDI, OSC and keyboard shortcuts can be assigned to all the parameters in the interface, so you
don't have to use your mouse to control everything.

See, that wasn't so scary.

https://resolume.com/support/parameters


Composition
The composition is your complete performance. It's how you've arranged your content and your
layers, the effects you've applied and how you've set everything up to be automated. Think of your
composition as your stage. It's where you arrange where everything goes and how everything
looks.

Your composition composites all your layers together, applies the final effects and then sends it to
your screen. If you're an advanced user, you can use the Advanced Output to further cut up and
warp your composition. Or you can send the end result to other applications via Spout or Syphon,
to further process it.

Settings
Via Composition > Settings, you can change a few important details of your masterpiece.

Name

This is how you will recognise this composition. It's also the filename Resolume will use to save it to
disk.

"You have strength. You shall be known as Usul, which is the strength of the base of the pillar. This
is your secret name in our troop, but you must choose the name of manhood, which we will call
you openly."

Description

Here you can jot down some notes about this composition, which will be saved as metadata.



Size

The resolution that your masterpiece will render at. Via the dropdown, you can select from a list of
common resolutions, the resolutions of currently connected monitors, or you can type in a custom
resolution directly.

FrameRate

This will limit Resolume's fps to a fixed maximum. 

On auto, Resolume will sync to your monitor's refresh rate. So if your monitor is set to 60Hz,
Resolume will render at 60 fps. Rendering more would be silly, because your monitor won't be able
to display those frames, and they would be thrown away.

This is the setting that you'll want to use for the majority of the time.

When you're pushing very high resolutions or when using lots of effects, it can be that your
computer can't keep up with what's going on. In those cases, Resolume will try to keep things at
60fps, but it will start dipping. Depending on how hard you're pushing things, your fps can start
fluctuating between 40 fps and 60 fps.

In those cases, it can be smart to limit your framerate to 30fps. That way, every frame takes exactly
the same time to render. This way, playback will be perceivably smoother. Also, effects like strobes
will be equally divided between on and off, instead of stuttering because they're strobing at 43 fps
at one moment and 57 fps the next.

Note! When your computer cannot keep up and is rendering at 23 fps, putting this setting at 60
does not give it magical powers. It will still have to do the same amount of work on the same
hardware, so it will struggle just as much as before.

Quality

This will let you switch between 8 bits per channel and 16 bits per channel rendering. This will give
you higher color fidelity when doing complex composites or applying intricate effect chains.

Tip! With great power comes great responsibility! This is not a magical switch that makes everything look



better. When set to render at high quality, your computer will need to work considerably harder. If your
whole production workflow is not 16 bpc, you are not likely to see an immediate difference.

Properties

In the top left of the interface, you will find a few powerful controls.

The Composition button will let you preview the composition, even when it's faded down.

The X button will let you eject all playing content in one click.

The B button bypasses the entire output, while the M slider gives you the same control under a
fader. 

Tip! Because the M slider controls the visibility of everything going out of Resolume, it will show red when
not set to 100%.

The S slider controls the speed of all playing clips at the same time. Note that the global speed
control has no effect on BPM-synced clips, as those are controlled by the master BPM clock instead.

The two arrow icons will let you trigger the previous and next columns. Yay!

Common

Here you can control the master opacity of the composition and the speed of all playing clips at the
same time.

These controls are linked to the ones above. In the composition panel, you have finer control
because you can both set and see the values numerically.

Audio

Gives you control over the master volume and pan.

Video

Fade out the video, independent from the audio.

Crossfader



The crossfader will let you assign layers and groups to a 'bus', and
then fade between buses. This way, you can put layers that look
good together on either side of the crossfader, and mix between
them quickly using a single slider.

You assign layers to a bus, by toggling the A or B buttons to the right of the layer's name. 

Resolume will then composite those layers together first. When the crossfader is all the way to the
left, it will only show the layers on the A bus. When it's on the right, it will show the layers on the B
bus. When it's somewhere in the middle, it will blend the two buses together.

In the composition panel, a few options can be set for the Crossfader.

Blend Mode

This determines what blend Resolume will use to composite the buses together. You can choose
one of the many blends that are available.

 Behaviour

This determines what happens when you press the A and B buttons to the left and right of the
crossfader itself.

Jump will make the crossfader go to that side immediately.
Jump & Return will do the same as Jump. When it's clicked again, it will return to the previous
side.



Cut is like Jump & Return set to 'piano', meaning it will return to the previous side when
released.
Fade (Legacy) will do a slow fade to the clicked bus over 5 seconds.

Curve

This sets a different mixer curve, changing the responsiveness of the
crossfader.

Direction Controls
With the global direction controls, you can quickly change the direction for all the
clips that are currently playing. You can switch the direction between forwards or
backwards, as well as set them all to random mode.

Tip! By right-clicking the button you can 'pin' the direction controls. That way, every clip you trigger will
automatically be set to this play mode. So when you right-click the R button, it becomes pinned, and every
clip you trigger will be set to random playback, regardless of how it was set before.

You can find the global speed and direction controls by choosing View > Show Layer Transport
Controls, they then appear in the top left of the interface.

Trigger Options

These are essentially the same as the trigger options for the clip. Except here you can set them for
all the clips in this composition. You can imagine this saves a lot of time on having to set these for
every clip individually.

Of course, the setting can be overridden by individual clips.



Decks

Each composition can contain a number of decks, which you can use to manage your videos, still
images, audio files and sources.

Decks are like the records in a DJs record bag. Keep them organised so you can always reach for the
right selection.

Decks are accessed through the set of buttons just below the clip layers. Each deck has a name.
When you select a deck, all of the clips in the deck are displayed in their layers.

Tip! If you're really adverse to clicking with the mouse, you can assign shortcuts to these two little fellas in
the far left of the deck area and scroll through.

Adding Content
Before you can starting having fun with your content, you need to get it into Resolume. You can do
this by dragging and dropping files from your operating system file browser or you can do it using
Resolume's built-in browser.



You will find the browser over to the right
of the display, in the Files tab.

The main part of the browser enables you to browse through folders by double clicking them. 

Tip! If you need to search through a long list of files and you already know the name of the file or folder
you're looking for, type the name into the search box to narrow down the list of possible suspects.

Click the dropdown at the top to show a list of root drives on your system, as well as a list of
favourites. You can add or remove items from the favourites list via the big heart icon in the top
right.

Next to the heart is a toggle that enables you to show or hide thumbnail images for media files -
really useful when you can't quite remember what you called that fantastic clip you made last night!
Also you can double click a clip name to preview it in the preview window, to be really really sure
that it is the fantastic clip you made last night.

Loading media into a clip is simply a case of dragging it over to a slot in the deck. You can drag an
audio file and a video clip or image file onto the same slot to make a combined clip. If you do this,
Resolume will automatically transpose the video to the length of the audio to make an audio-visual
clip.

Check out the Preparing Media page for tips on optimising your content for Resolume.

https://resolume.com/support/preparing-media


Managing Clips
Think of clips like words in a sentence. Just like using different words can drastically change the
meaning of a sentence, using different clips together can drastically change your output.
Sometimes some words don't even make any sense at all. So you also want to keep clips together
that, when used together, create something awesome.

This is where decks come in. When you have some clips that work well together, you put them in a
single deck. That way you can keep them together and always access them.

You can arrange clips by theme ("all the space clips"), color ("all the blue clips"), rhythm ("all the
slow clips"), type ("all the audio-reactive clips") or whatever you think makes sense. 

The point is that managing your clips is super important to playing a good show.

Tip! The same clip can be used more than once in another deck, or even more than once in the same
deck. This way that trippy kaleidoscope clip can be part of your 'Psychedelic' deck, but also your 'Colorful'
deck and also your 'Backgrounds' deck.

Once clips have been added to a deck, you can move them around by clicking and dragging the clip
name below the thumbnail of each clip. If you drag a clip over an already added clip, they will swap
places in the deck. You can also drag a clip just to the right or left of another clip. This will insert the
dragged clip next to it, and shift over the others to make room for it.

If you want to copy a clip, drag the clip to the new position and then hold down the Ctrl key (Alt on a
Mac) as you release the mouse button. A copy of the clip will be created and the original will
remain. You can also use the universal copy, cut and paste commands CTRL-c/v/x (or their CMD
equivalents on a Mac), allowing you to paste a clip into a different deck as well. You can even use
shift and CTRL/CMD to select multiple clips and copy/paste multiple clips at the same time!

Tip! A good way to organise content is to have similar clips next to each other on the same layer. A layer
is a horizontal row of clip slots. This way, you can easily select different clips without breaking the visual
theme. You can also organise your content so that clips that look good when played together are all in the
same column. A column is a vertical row of clip slots. Then you can play them all at the same time by



triggering the column, using the column itself as the trigger.

Using Decks
Instead of loading a whole composition with all its decks, single decks can be added to the current
composition as well. Just double click the deck in the Composition browser. It will then be added to
the current composition as a new deck. Very useful for those inevitable moments half way through
your set, when you realise you feel like playing content you didn't prepare.

A good way to be prepared for those moments, is to
keep one or more 'master compositions'. These
master compositions are not meant for a single
performance, but rather contain your footage, pre-
organized per theme. For instance, one master comp
could contain all your 1080p material.

Every time you have some new 1080p content, you open the 1080p comp, and add a new deck with
the new material. Or you could of course add the material to already existing decks if they fit the
theme of that deck. At this point you can also set clips to be BPM Sync or Timeline, apply effects to
clips, and arrange clips together in columns.

After you've added the new footage, save the comp, close it and leave it be.

Then, during performance, when you realise you feel like playing a certain set of clips, you don't
have to search your computer for them, or add and set them up during show. You can just double
click its deck in your master comp, and it will load for you in your current show composition, with all
the clips in the right place with the right settings.

Organising Decks



A new deck can be created by using the Deck > New or Deck >
Insert Before or After menu options. The New option adds the new
deck to the end of the list while the Insert option adds it before or
after the currently selected deck. You can also duplicate the current
deck.

To change the order of decks, just drag em around.

Closing a deck will remove a deck from the current screen, but keep its contents intact and it will
remain part of the composition. It will remain closed until you open it again.

Clearing a deck removes all its contents, but keeps the empty deck open. Removing a deck will
delete it in its entirety.

By default, when you add the first file to a deck, it will get the name of the folder that contains that
file. If that doesn't mean anything to you, you can use the Rename option to give it a more
meaningful name.

You can also use color coding to mark your decks more clearly.



Groups
Groups are available on Arena only!

Sometimes, you have a set of clips that work particularly well together. You know, those two or
three clips that, with just the right blend mode, melt together to become a completely new piece of
content. Wouldn't it be great if you could control those clips with one fader, apply effects on them if
they were one clip, and could even move them around and scale them like they were one clip?

That's where groups come in.

Groups are essentially little sub-compositions. You can use them to group layers together, and treat
them as one big, new layer. 

Creating Groups
You create a group by selecting the first layer you want to add to the group, right-clicking it and
selecting Group > New.

This will put the layer in the group. You will see this reflected in the interface, by the layer being
slightly indented, and the newly created group will 'hug' its new baby. Also, the group panel will
appear next to the layer panel.



Adding and Removing Layers
At this point, adding and removing layers to and from a group is very easy. You can simply drag
them by the layer name handle, and either drop em in, or throw them out.

Keep in mind! A group can never be empty, as this would mean the group disappears and you
could lose all its effects and settings. So when you drag the last layer out of the group, Resolume
will create a new empty layer in its place.

If you're more of a menu type of person, you
can also use the layer menu to move layers out
of groups.

Group x - If another group is available, selecting it will move the selected layer there directly.

None - This will remove the selected layer from the group.

New - This will create a new group and put the selected layer in it.

You can create as many groups as you like.



What Happens in the Group, Stays in the
Group!
Groups are a hybrid between a little sub composition and a layer.

They have a lot of the same functionality that the composition
has. Groups have their own little column trigger, their own
little master speed slider and playback controls, as well as their
own master bypass, solo and eject buttons. 

Of course you can apply transforms, effects and masks on the group level. 

Groups also borrow some functionality from layers, like Ignore Column Trigger and Lock, which are
applied on all layers in that group. 

The only difference is that what happens in a group, never leaves that group.

On the one hand, this means obvious things like that group column triggers won't affect layers
outside the group, and pressing the group eject button, only ejects layers in the group.

But it also means less obvious things. 

For instance, you can't route layers to a Layer Router outside the group, and you can't crossfade to
a layer in a group if the group itself is on another crossfader bus. This prevents you from
accidentally tearing a hole in the space time continuum. Because that's what will happen when you
start doing weird things like that.

And no, you can't put a group in another group. You are not Leonardo Dicaprio and you are not
asleep in a van falling from a bridge in Paris.

Group Blending
Groups start you out with a blank canvas.

Regular layers will blend with the layers beneath them, depending on their blend mode and



opacity.  Layers in a group only blend with the other layers in the group. 

The first layer of a group is first rendered on a transparent black background. It doesn't blend with
the layers underneath it. The other group layers are blended on top of this first group layer.

The final result of this is then blended back in the composition. The group has become a single
flattened layer at this point. You can use the group's blend mode and opacity to control how it's
mixed with the rest of the composition. 

Groups default to Alpha blend mode with 100% opacity.

Group to Slice Routing
Groups are also available as input for slices in the Advanced Output. This will let you route multiple

layers to a single slice.

Keep in mind that you can no longer use the group blending mode at this point. Also, routing a
group to a slice means you bypass all composition effects.



Layers
Think of your composition as a painting, and you're creating 60 artworks per second. Every layer is
layer of paint on your canvas.

We start at the bottom, with a blank canvas. Layer 1 is the first layer of paint we put on. Then we
add Layer 2, then Layer 3, slowly adding more and more layers on top of it, until we have a
masterpiece. Or a great big mess. Sometimes both. It's your little world, and you can make it as
happy as you want it.

Some people think that the first layer should be at the top. I guess that's because we're used to reading a
book starting at the top left of the page (in a Western culture anyway). However, it's very rare to start a
painting by applying the top layer first, and then gradually adding more paint underneath. Since we're
artists painting a masterpiece, and not writers writing a novel, the first layer is the bottom layer.

Blending and Compositing



The first layer of paint is always applied on black. It will fill the entire canvas and you have full
control over how thick you apply the paint. Simply grab the 'V' slider to fade the layer in and out.
Similarly, if you're playing audio, you can use the 'A' slider to fade the audio in and out. Or grab the
'M' slider to control both at the same time.

The fun really starts when you start blending layers together. Blending is like painting 'wet on wet'.
The new layer of paint will blend with the paint that's already there. This way, every layer you add
can be blended with the ones below it, in a variety of ways.

The default blend mode is 'Add'. Using Add, you simply add the new layer on top of the previous
one, adding the pixels together. This is a great way to mix clips together that have a black
background. 

Don't care about math? Feel free to skip ahead. Still here? Great. Black pixels have an RGB value of zero,
and adding zero to something doesn't add anything. This is why black pixels become transparent when
using the Add blending mode. Also, you're a nerd. Who likes math? Seriously.

Too Much of a Good Thing
Of course, you can have as many layers as you like. Or at least until smoke starts coming out of
your computer.

New layers can be added with the Layer > New and Layer > Insert menu options. The New option



adds the new layer to the top of the layer stack while the Insert options add the new layer above or
below the currently selected layer. If you're a shortcut type of person, you can hit CTRL-L (or CMD-L
on a Mac) to add a new layer as well.

This is a good moment to talk about composition, as in how you compose your overall visual
output. It's very easy to keep stacking layer upon layer, but as the saying goes, less is often more. 3
layers can already be more than enough. A good composition gives each layer room to breath,
instead of smearing every pixel shut.

The danger with Add blending is that, well, there's no other way to say it, it adds up. When using as
little as 3 layers together, the result quickly becomes a white soup. Soup tastes great, but it's not
very nice to look at. Also, when you're playing on a LED wall, the people in the front are now acutely
aware of how silly they look and that that one boy they were flirting with is actually a speaker with a
coat hanging from it.

Luckily, Resolume has many different ways to blend, including ways to make the output darker
instead of brighter.

You change the blend mode by clicking on the dropdown marked Add, and choosing one from the
big list. Let's go with Darken for the second layer, and Dodge for the third. 

There, much better. We can still see the texture and design of every layer, but the result is not so
overwhelming.



Alpha Blending
By far the cleanest way to paint is to use content with an alpha channel. Clips with an alpha channel
have transparency baked into them, so you can stack layers on top of each other, without mixing
the paint. This way, you can precisely control which pixels to show and which ones to hide, while
the overall composite stays crisp and clean.

Most of the content you purchase in the Resolume shop has an alpha channel. If your content
doesn't, you can use the Auto Mask effect to turn the black pixels transparent. You will need to play
around with the Contrast parameter to get the desired result.

A good way to approach a composition with alpha channels is to use a Background / Focus /
Frame approach.

Your first layer will be your Background. You use this layer to paint the entire canvas with a screen
filling loop. This gives your composition texture, and a base to start with. Abstract loops with some
kind of pattern are great for this.

On top of this, you use the second layer to paint a more recognisable element. This is to grab the
viewer's Focus. Faces are always a winner, but you can use anything that has some connection to
the music or theme of the stage. If you're commercial oriented, this would be a great place for the
DJ's logo.

The third layer will be used to Frame what's underneath. The layer will be used as a window,
blocking some parts of the content underneath. Often used in movies, blocking the layers below
gives a sense of depth to the overall composition, and constantly hiding and revealing parts of the
composition keeps everything dynamic.

Of course, nothing is stopping you from using more layers, or even using multiple focus points on a
more complex stage design.



Types of Blends



Unfortunately, this manual is not long enough to go into detail into what each
blend mode does exactly. 

Blends

These will blend and mix the paint of your layers. At 50% opacity, they will fully mix the paint with
the layers underneath. At 100% opacity, they will just fully cover the paint underneath, as if you're
putting a completely new layer of paint on your canvas.

Some blends will create a brighter output, like 'Add', 'Lighten' and 'Screen'. Others will darken the
output, like 'Subtract', 'Darken' and 'Multiply'. Some just do weird stuff like 'Difference I' or 'Dodge'.



It's best to just sit down, grab a cup of coffee or tea and try them all out. Get a general feel for what
they do. Remember to try them with different types of content, as that can create very different
results, depending on the blend.

50 Blends

These are special types of blends. They do the same as their regular counterpart, except that they
mix their paints with the opacity at 100%. They're especially useful for doing AV mixing, because
you can have both the audio and video sliders all the way up. Or if you like throwing your midi
faders all the way open like a superstar DJ.

Transitions

Some blends are actually transitions. By fading the layer from 0% to 100%, some sort of transition
is applied. 

For instance, 'MultiTask' will do a Cover Flow type of transition, where the new layer will come in
from the side and push the layer below to the back. 'Shift RGB' will bring in the Red, Green and Blue
channels of the new layer in from the left, right and top.

Transitions work best for presentation type of shows, but for instance 'to White' can work great to
bring in a new layer with a bang during a VJ set.

Eject, Bypass and Solo

These three bad boys can be found on the far left of the layer strip.

The X will eject the currently playing clip from the layer.

The B will bypass or Blind the layer, temporarily hiding it from view.

The S will Solo the layer, hiding everything but the current layer. This is useful to quickly focus on a
layer when troubleshooting, or as a visual effect during show to emphasise a certain element.

Be careful you don't end up in a BS situation, where you both Solo and Bypass a layer, because
then you end up with a whole lot of nothing.

Layer Order
You can change the order of layers simply by dragging a layer by the name handle and dropping it



where you want it. 

Layer Transition
Layer Transitions will let you add a transition when you trigger a new clip in a layer. This
way you can smoothly blend from the old playing clip to the new one.

The auto layer transitions can be found by choosing View > Show Layer Transition Controls, and
they will pop up to the left of the clip thumbnails.

Once visible, simply fade up the vertical slider to set a transition time between 0 and 10 seconds. If
you like numbers as much as I do, you can also set the transition time precisely down to the
millisecond in the Layer panel.

The transition mode will default to Alpha, which is a simple crossfade. If that's too basic for you, you
can choose all of the available blends and transitions instead. 'Twitch' is one of my favourites. Also,
'Cube' is amazing just for sheer corniness.

If you really can't decide on a favourite transition, there is also a random option, giving you a
different transition every time you trigger a new clip. 

Previous / Next Clip
Yes! These buttons will let you trigger the next or previous clip in that layer. Yes, you can
also assign MIDI and keyboard shortcuts to these buttons.

These buttons come as a bonus with the Layer Transition Controls, and can be revealed via View >



Show Layer Transition Controls.

Layer Properties
To select a layer, click the area that displays the layer's name, for example Layer 1. The currently
selected layer is highlighted in blue.

Auto Pilot
This will let you play a sequence of clips in a layer. When the current clip has reached the end,
Resolume will trigger the next, previous or a random clip automatically.

Tip! Clicking the Next, Previous or Random button before the current clip has reached the end will force
the Auto Pilot to do its thing prematurely. Don't worry about it, triggering prematurely happens to
everybody. You were probably just nervous.

The Auto Pilot can also be set on the Clip level. In that case, you have the extra option to target the
first, the last or even a specific clip in the layer directly.

Common
This contains the Master fader for the layer. This fades both the playing audio and video at the
same time, without affecting their individual levels.

Audio
This will let you control the Volume and Pan of the audio playing in the layer.



Video
Here you can choose the Blend Mode and Opacity of the layer. These controls are the same as can
be found on the layer strip in the top.

Width & Height will let you change the resolution the layer renders at.

Tip! Lowering the Width & Height can save you considerable render power. For instance, you can render
an 7680x4320 composition, with four layers each set to 3840x2160, positioned in the four corners. Each
layer will only process at the resolution its set to, instead of processing at the full 8K resolution.

Auto Size is great to make sure your content always matches your layer size. You can set all
content to automatically Fill, Fit or Stretch to the layer size.

Off will keep the content as it is.
Fill will make sure the content fills the entire layer, while maintaining its aspect ratio. This will
result in the sides or the top and bottom of the clip being cropped off. 
Fit will make sure your content is completely visible, while maintaining its aspect ratio. This
will result in black borders being visible on the sides or top and bottom.
Stretch stretches the clip to the layer width and height, distorting the content when
necessary. 

Layer Transport Controls
The Layer Transport Controls give you quick access to the transport section of the
clip currently playing in that layer.

These will let you quickly change the speed, direction and loop mode of the clip. Also you can grab
the playhead and scratch it. When in BPM Sync mode, you will see the amount of beats instead of
the speed.

Practically, these controls can also be found on the transport section on the clip tab, except you can
see and control more than one clip at the same time. Changing anything in one place, will also
update it in the other.

You can show and hide the Layer Transport Controls via View > Show Layer Transport Controls



Trigger Options

These will set particular trigger options for all clips in a layer. They can of course be overridden for
individual clips on the clip level.

Ignore Column Trigger
With this enabled, any clips in this layer will keep on playing when a column is triggered. This is
useful to keep clips like live inputs or background around, but change all the other content with a
single click.

Trigger first clip on load
After the composition has finished loading, the first clip in the layer will be triggered automatically.
After this, any Auto Pilot actions will be executed normally. You can use this to do basic installations
with Resolume, or to quickly get a test card up and running when you launch the software.

Fader Start
This will retrigger the current clip, every time you bring the opacity up.

Mask Layer
A layer can be set to Mask Mode, masking either
all the layers below, or just one layer.

In Mask Mode, the layer will use the black and white values of the content currently playing in the
layer to show or hide the layer(s) below. Alpha will be treated as black.

To give a visual indication of what's going on, Resolume will show
the thumbnails in greyscale. Also, it will show a little corner with a
transparency checkerboard, as a visual reminder this layer is

currently being used as a mask.

All Below will apply the mask on all the layers below the Mask Layer. It's essentially the same as
setting the layer to Mask50. 

One Below will apply the mask on just the layer right underneath the Mask Layer, and leave the
other layers unaffected. If you're familiar with After Effects, it's the same as setting a layer to Luma



Track Matte.

Disabled will set the layer back to be a normal layer again.

Lock Content
This will let you lock the content currently playing in the layer.

All this does is make sure that you cannot accidentally eject the current clip or trigger a different
clip into this layer. Both the layer and clip parameters can still be controlled and changed.

As a visual indication, a lock icon is displayed over the layer thumbnail.

Duplicate, Rename, Clear and Remove
Of course you can Duplicate, Clear, Remove or Rename a layer as well. I think it's pretty obvious
what Duplicate does.

Rename is kind of special. Obviously you can use it to rename the layer. It's special because you can
use # as a special character. When displaying the name, Resolume will replace the # character with
the current position the layer has in the stack. So for instance naming the layer "L# Mask", will
display the layer name as "L3 Mask", if it's the third layer in the stack. Moving the layer up or down
will automatically update the displayed name.

The difference between Clear and Remove is that Clear just clears out all the content from a layer,
but keeps the layer itself around. Remove will get rid of both the content and the layer in one fell
swoop.



Clips
Clips are the real nuts and bolts of Resolume. Without clips we wouldn't have any content to throw
at the screens and speakers.

A clip is usually a video. But it can be a lot more than that. A clip can also be a still image. It could
also be an audio file, or even a combination of audio and video.

Clips can also contain Sources - like a live camera or plugins that generate content on the fly.
Basically a clip is any type of media you create your output with.

Triggering Clips
Triggering a clip is as simple as clicking its thumbnail. When you're sick of a clip, you can either
trigger a new one in its place. Or press the big X to the left of the layer to eject it.

That's it. That's really all a good VJ does. Trigger the right clip at the right time. You can now stop
reading the manual.

Still here? Cool. Because there are some options for what happens when a clip is triggered. 

Tip! Want to change a setting before a clip is live? No problem. You can select a clip, rather than trigger it,
by clicking the name handle underneath the thumbnail.

Multiple Clip Selection

All the functions described below can can be changed for multiple clips at the same time as well.
Shift select the clips, and then change the function via the Clip menu or the right click drop down.

Beat Snap

https://resolume.com/support/sources


You can use the Beat Snap option to have clips wait
until the next beat, the next bar, in 2 bars, in 4 bars
and so on before it starts. This is particularly useful
for audio-visual music clips.

In some music software, this feature is known as "Quantising".

You can  set the Beat Snap option for an individual clip. Select the clip and select the Clip > Beat
Snap menu option.

If you set the clip setting to 'Composition determined', it will use whatever the Composition setting
is.

You can set the Beat Snap option for the whole Composition through the Composition > Beat Snap
menu options.

 

Clip Target



The default thing that happens when you click a clip
is that it plays on the layer it is held in. You can also
set clips to play in the active layer or even to use the
next available layer.

Like Beat Snap, you can change this setting for the whole Composition (Composition > Clip Target)
and for individual clips (Clip > Clip Target)

The Free Layer Clip Target mode is particularly fun when used with the Piano Trigger Style mode
(see below).

You can then play 'chords' of clips with the keyboard or a MIDI device - each of them will be
displayed for as long as it is selected. 

Obviously, you will need as many layers as you want to play simultaneous clips.

Trigger Style



Normally, when you click a clip, it starts playing and
carries on until you clear the layer or play another
clip. 

With the Trigger Style setting, you can also use Piano mode, where the layer is automatically cleared
when you take your finger off the mouse button, or MIDI key or keyboard button if you are using
shortcuts.

You can set the Trigger Style for the whole composition through the Composition > Trigger Style
menu option.

You can set the Trigger Style for an individual clip by selecting it and then using the Clip > Trigger
Style menu option.

Auto Pilot
Using the Auto Pilot, you can let Resolume automatically play a different clip when the current clip
finishes. Options include the next and previous clip, a random clip, the first or last clip in a layer, or
even a specific clip.

You can also turn on the Auto Pilot for the whole layer. Handy for that quick bathroom break. Or
when you need to explain that you're really not the DJ to that one person that won't stop
requesting that new banger by DJ Snake.

Fader Start



When Fader Start is enabled for a clip or a layer, the
clip will re-start from the beginning every time you
fade up the layer it's playing in. 

This is useful for clips that should start exactly from the time you bring them in, like song lyrics or
intro animations. You can keep them triggered in a layer, ready to go, and when the moment
comes, start them by fading them in.

Tip! In combination with the "pick-up' playmode (described further below), you can also turn this feature
into a Fader Stop. The clip will then remain paused where it was the moment you fade down the layer,
and continue where it was when you fade it back up.

Fader Start can be set per clip (Clip > Fader Start), or the whole layer (Layer > Fader Start).

Ignore Column Trigger
This option allows you to 'lock' a clip or entire layer, so that when you trigger another column, that
particular clip will not get replaced and just keeps playing. The option can be found in both the Clip
and Layer menus.

This is particularly useful when using a single clip as a background, or when you are using
Resolume to record a video clip, and you want to keep playing a single audio track while you're
mixing.



Resize
Here you can quickly set your clips to either
Fill/Fit/Stretch to the current compositions size, or go
back to the original pixel dimensions.

This is not a setting that stays fixed! Rather it's a quick way to make sure all your clips are the
correct size, and you can go into the clip properties and further tweak the values.

Not sure what Fill, Fit and Stretch do exactly? They're explained below, where we talk about the Clip
Properties in greater detail.

Thumbnails
Oh yes! You can update the thumbnail of a
clip to the current frame, or even to how it
looks with the clip effects applied. If you're
really picky about your thumbs, you can

even load a still from disk.

Not happy how your thumbnails turned out? You can always revert back to the original.

Persistent Clips
Persistent clips carry over from deck to deck. You can mark one or more clips as persistent via the
Clip menu. When you then switch to another deck, these persistent clips will be loaded in the same
slot in every deck you switch to. 

This is useful on longer shows, where you always want to have access to a particular set of clips, but
not be tied down to a single deck. Promotor logos, flashes or live cameras come to mind. 

Did you have an important clip in a deck, which is now covered by a persistent clip?
Don't worry! 

Resolume will let you know there was another clip in the slot by showing it as a little thumbnail in
the top left. You can use this thumbnail to free the clip. Just by dragging it to an empty slot.



Cut/Copy/Paste/Clear/Rename
If you really don't know what CTRL-c and CTRL-v do, I suggest sitting
down with a good friend and asking him or her to show it to you. 

Also, props to you because I wouldn't have made it through college without copy/pasting stuff from
people that were smarter than me.

Paste Effects
One option that may stand out is 'Paste Effects'. This will let you copy a clip into memory using
CTRL-c, and then paste just the effects onto one or more other clips using Paste Effects. This
feature may be familiar to you from good old Final Cut Pro and it's a really quick way to get the
same look on a set of clips.

Reveal/Strip Video/Strip Audio
These will show the original clip in Finder or Explorer, or let you strip
the audio or video track from a clip. 

Careful! Removing the video track when there is no audio track will effectively delete the clip! Don't
say I didn't warn you!

Clip Colors

Yes! You can now give each clip or set of clips its own nice pastelly highlight.



Clip Properties
The clip properties give you important info about the clip. Geeky stuff like the codec and fps, but
also useful stuff like the length and default BPM.

When you toggle down the individual audio and video properties, you get access to some more
finetuning options.

Audio Properties
The audio properties are only visible if your clip has an audio track. Duh.

Use the X button to delete the audio track. You can use this to remove the audio track from a video
if you do not need it, or want to change it.

Using the audio properties, you can set the volume for this clip individually. This is useful for
balancing the volume of clips that will play on a layer. Also you pan this clip individually.

Video Properties

Tip! Drag a video clip from the browser over the blue video area. This allows you to replace the content,
but keep any effects and parameter changes you had applied to the original!

Use this bad boy to resize the clip to the size of the current composition. This is great when
your content isn't at the right size already. 

Clicking this multiple times will cycle through a few options available for scaling. 

Fill. This will make sure the clip fills the entire composition, while maintaining its aspect ratio.
This will result in the sides or the top and bottom of the clip being cropped off. 
Fit. This will make sure your clip is completely visible, while maintaining its aspect ratio. This
will result in black borders being visible on the sides or top and bottom.
Stretch. This stretches the clip to the composition width and height, distorting the clip when
necessary. 
Original. This returns the clip to its original size. 



Click this to clear the video from the clip, leaving the audio intact.

Use the RGB toggles to subtract colour channels from the clip. Using combinations of
these, you can quickly colorise a clip to the three primary Red, Green and Blue, as well

as the secondary colours Cyan, Magenta and Yellow.

The A toggle can be used to disable transparency in a clip. This will only be available if your clip has
an alpha channel in it.

When you fold open the extended properties, you get access to Opacity, Width & Height, Blend
Mode and Alpha Channel interpretation of a clip.

Opacity

This will fade out the visibility of your clip, gradually fading it to black.

Width & Height

Here you can change the resolution of the clip using exact pixels.

Blend Mode

This will let you set which blend mode this clip uses when it's playing in a layer. This will override
whatever blend mode you have selected on the layer, for as long as this clip is playing.

Alpha Type

Here you can tell how to interpret the alpha channel information in your clip. Resolume will default
to "Premultiplied". This is the default setting that After Effects uses for exports with an alpha
channel. So most of the time, you don't even have to worry about this.

Are you seeing a weird halo around your edges? Then you probably want to switch to "Straight".



Effects
Effects are super awesome! Everything playing in Resolume can be manipulated by effects. All of
the audio and all of the video.

When you get right down to it, each effect is a small program that changes the audio or visual in
some way, controlled by parameters. You send this little program whatever is currently playing, it
does its magic based on how you have it set up, and then it spits out the result back to Resolume.

Resolume comes with a whole bunch of video effects built-in, more than a 100! It also has a handful
of basic audio effects. If that doesn't cut it for you, you can read more about adding even more
effects below.
You can find all of them in the Effects tab, which can be found in the bottom right of the interface.

To preview an effect, double click its name in the browser. It will show in the Preview Output,
applied over whatever is playing in the composition. You can then tweak its parameters, to see if
you can get the look youâ��re after.

If you've found the right effect for the right moment, just drag the effect from the Effects tab onto
the area of either the Composition, Layer of Clip tabs. Drop it right where it says 'Drop effect or
mask here'. You can also directly drop it onto a clip or layer.



Tip! Hold down ALT while dropping an effect to apply it with its opacity turned all the way down. This way
you can tweak its parameters, and then bring it into the mix gradually.

Clip effects are applied to the individual clip when it is playing.

Layer effects are applied to whatever clip is playing in the layer, after its clip effects have been
applied.

Composition effects are applied to the final output, after the layers have been mixed together.

All effects can be temporarily bypassed (B toggle) or removed (X button).

If you're an Resolume effect ninja and already know the name of the effect youâ��re looking for,
you can type its name into the Search box at the top of the effects browser.
Tip! Hit CTRL-/  (or CMD-/ on a Mac) to focus the box without having to reach for your mouse. 

Why the '/' key, you ask? Because it's just like hitting CTRL-?, just without the SHIFT key.

https://resolume.com/manual/_detail/effectsapplied.png?id=en%3Ar5%3Aeffects


Using Audio Effects
Depending on the effect, audio effects can have any number of parameters. But there is one that
they all share. The "Dry/Wet" slider controls how much the affected version for the audio is mixed
with the original. 

When this parameter is moved over all the way to the right, you hear the full result of the effect and
none of the original audio. When its moved to the left, the effect will not be heard at all. 

Using Video Effects
Similarly to audio effects, video effects always have at least two parameters: â��Opacityâ�� and
â��Blend Modeâ��. You use these to mix the effect with the original video. As with mixing layers,
different combinations of blends and opacity levels can have very different results.

To make sure you see only the result effect and nothing but the effect, select the Alpha blend and
turn the opacity all the way up.

Aside from this, this manual is too short to tell you what every parameter of every effect does or
how you should use it. You can try them out and wiggle a few of the controls to find out yourself.
You'll figure out which ones you like soon enough. Some of our personal favourites are: Vignette,
Hue Rotate, Stingy Sphere, PolkaDot, Goo and Particle System.

Presets

All effects support the creation of presets. Each preset contains all the settings for an effect -
enabling you to quickly activate an effect, set to just the right sweet spot.

To create a preset, first get the effect working how you want it. Work the controls until the output is
juuuuust right. Then use the Preset drop down above the effect parameters and select the Save
As... option.

Enter a name and hit return.

The new preset will now appear in the effects list, under the name of the effect itself. To use a
preset, drag it onto the Composition, Layer or Clip in the same way as you would for the effect
itself.

It helps to think of presets as a big octopus. Wait. What? I know you may have seen enough hentai
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to know where this is going, but stick with me. It'll make sense in a minute. 

When you apply a preset, the octopus uses all its tentacles to quickly set all the parameters to the
right settings in one go. After that it swims away again. The effect doesn't remember which preset
was used to get its current settings. It doesn't even care if the octopus did it, or you did it yourself
by setting everything by hand. So, when you update a preset, other effects that were set to this
preset by their octopus don't get updated with it. The octopus just visits once, and then disappears
in a big inky cloud.

Doesn't make sense yet? Well, I tried. Just remember presets are a way to quickly set an effect's
parameters to specific values. Not a way to keep all your effects in sync.

Multiple Effects
Thus far, we've only talked about applying a single effect. But you can apply as many effect as you
want. You can keep going until everything is one big nasty pool of ugly pixels. Or until smoke comes
out of your computer. Whichever comes first really.

Effects can be stacked together by dropping more than one into the same place. If you do this, they
will be applied in order, starting with the top one in the slot. Each effect will be applied in turn,
affecting the output of the previous effect.

You can change the order of the effects by dragging them by the three horizontal bars on the right
of the effect name. 

Changing the effect order can dramatically change the resulting output. For example, you could
apply the PolkaDot effect on a clip, followed by Radar. Looks cool, right? Now see the difference
when you drag Radar above PolkaDot. The difference is subtle, but important!

First PolkaDot, then Radar.



First Radar, then Polkadot.

Tip! Transform is an effect just like all the others. So you can stick transforms anywhere in the render
stack.

Bonus Tip! Because Transform is an effect like all the others, you can also save your own Presets for it.

Effect Clips

Effects can also be added to an empty clip. When you do this, you will create an Effect Clip. If you're
used to working with Photoshop or After Effects, you'll know this feature as Adjustment Layers.

Any effects applied on an Effect Clip will be applied to all the clips playing in the layers underneath
it. This way you can very quickly create a sequence of different looks and effects, while still being
able to swap out the footage on the fly.

Even better, this will allow you to assign MIDI or keyboard triggers to effects, or even fade from one
effect to the other using the layer transitions.

Like Sources, Effect Clips can be assigned a duration as well, so you can use them with the Auto
Pilot too.
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More Effects
The built-in effects in Resolume are super powerful, and should cover most of your needs. In fact,
theyâ��re so versatile that a few years ago, we ran a competition to see who could create the best
looking content with them. Instead of creating content with After Effects or by filming something
with your camera, the only rule was that you could only use the built-in sources and effects in
Resolume. People made some super amazing content, and you can still browse the results.

But, still it could be that you have a need for even more. For audio, Resolume supports VST plugins.
For video, Resolume supports FFGL plugins.

We keep a list of all the FFGL plugins we know about. Note that for Resolume 6 and up, the plugin
needs to be compiled for 64 bit.

To load a 3rd party plugin, simply copy the .dll (PC) or .bundle (Mac) file to the 'Extra effects'
subfolder in Resolume's user folder in Documents. Restart Resolume, and your plugin will be
loaded automatically. If you like, you can also add your own custom folder to scan during startup.

For VSTs, you can similary add your own folder to scan for VSTs.

http://resolume.com/forum/viewtopic.php?f=11&t=10134
http://resolume.com/blog/11828/world-wide-ffgl-plugins-list-free-and-premium


Transform

Every panel has a default Transform effect applied. Depending on which panel you're looking at,
the Transform effect will let you adjust the position, scale, rotation and anchor point of this
composition, this group, this layer or this specific clip.
Each Transform effect has several parameters.

Position

Adjust where the content's center point is on the X and Y axes. 

Well, actually, *shoves glasses a bit further onto nose.* Actually, it adjusts where the anchor point
of the content is on the X and Y axes. Yes. For all intents and purposes, let's just say Position means
you can move them pixely things here and there.

Scale

Adjust the size of the content, proportionally to its original size. Expanding the parameter will let
you scale the width and height individually.

Rotation

Measured in degrees, this will let you rotate the content around its anchor point. Expanding the
parameter will let you rotate along each axis individually.

Anchor Point

If you don't know what an anchor point is, think of it like sticking a pin in the Justin Bieber poster



you have on your bedroom wall. Okay. Fine. The Justin Bieber poster that "your sister" has on the
wall. Whatever, man. No judging.

Depending on where you've stuck the pin, when you now spin the poster, it will spin around a that
point. This is exactly what the anchor point does in Resolume.

The anchor parameter can also be expanded.

Multiple Transforms
You can apply more than one Transform! Transform is available as an effect in the Effects list, and
you can apply it anywhere in the effect chain. This way, you can do crazy stuff like first scale down
and move a layer to the left half of the screen, then apply a mirror effect, and finally position the
result of this in the bottom right of the composition. Options galore!

Any transform you apply after the first one, will have its own Opacity and Blend Mode, just like an
effect. This way, you can control how the Transform blends with the input texture. 

The very first Transform in each panel can not be deleted.

Transform Presets
Each Transform setting can be saved as a preset. This gives you quick access to PIPs and scalings
that you often use.



Slice Transform (Arena only!)
On Arena, you get access to a very special type of Transform. 

It's available as an effect under the moniker Slice Transform, but the best way to access it, is to
open the Slice panel via View > Show Slices.

The Slices panel will show you all the screens and slices you currently have available in the
Advanced Output.



Now, by dragging the Screen onto a clip, a layer, a group or the whole composition, you can
instantly place content in every slice in that screen. 

The Slice Transform effect works with regular slices, polygon slices and fixtures, takes into account
the orientation of the slice, and respects any input masks applied on the slice.

Changing the slice in the Advanced Output will update the scaling of the content automatically.

Scaling

Fill

By default, the content will be scaled to Fill within the slice. This will fill the slice with the content,
and crop the sides or top and bottom if the aspect ratios don't match.



Fit

You can switch to Fit, in which case it will scale the content to be completely visible in the slice,
possibly adding empty pixels on the sides or top and bottom.

Stretch

By using Stretch, the content will be warped to match the shape of the slice exactly.

Mask

In Mask mode, you leave the content as it is, and essentially use the Slice Transform as a mask to
show and hide specific parts of it.

Bypass/Solo/Delete
You can use the B toggles to temporarily hide content for that specific slice. The S button will Solo
that slice and hide the others. 

If you don't need content to show in a particular slice, you can hit X to get rid of it.

If you realise you needed it after all, you can simply drag the slice back in from the Slices tab.

Orientation
You can use the Pacman icon to toggle each slice through 4 orientations: Regular, Mirrored
Horizontally, Mirrored Vertically, Mirrored Horizontally and Vertically.

Layering your Stage
Of course, instead of dragging the whole screen to create the Slice Transform effect, you can also
drag a selection of slices instead. 

This is a great way to assign content to specific areas of your stage. For instance, you can show the
DJ name, set to Fit on just the main screen and DJ booth, while showing the promotor logo behind
it, set to Fill on the main screen and on the tiles on the roof. Background content can be shown
everywhere, masked on every slice.

Because Slice Transform is an effect, you can use it to apply these looks on specific clips. This way
you can have multiple instances of a clip, each with a specific look.

Also, you can create presets to quickly recall specific looks and switch between them.



Missing Slices
Because Slice Transform works with the slices in your Advanced Output, it might be that a particular
slice can't be found. Maybe you accidentally deleted it, maybe you've loaded in another preset. 

Whatever the reason, Resolume doesn't panic. It just lets you know something is missing by
highlighting the slice in red. Any remaining slices will continue to display just fine.

This is done to give you an indication that something is up. You can then go in to Advanced Output
to do what needs to be done to correct it, or just delete the slice from the effect if you don't need it
anymore. 

When you accidentally deleted a slice in the Advanced Output, undoing it will bring it right back,
both in the Advanced Output and in the Slice Transform effect.



 



Output Setup
Unless you are just using the recording feature of Resolume to make video clips, at some point you
will want to route the video from Resolume out of your computer, hopefully to a really big screen.

Before you can configure the outputs in Resolume, you will need to set up the displays in your
computer's operating system. You should do this before you run Resolume, in order for the
displays to be available in the Output menu.

So first we make sure the display or projector is recognised by your computer.

Setup your computer

Windows 
To set up the displays in Windows, open the Display panel via the Control Panel: Settings > System
> Display. Alternatively, you can right-click on the Desktop and select Display Settings from the
contextual menu.

On the settings tab make sure you have at least two displays visible and active. This is usually called
having the two screens in 'extended desktop' mode.



Mac OSX 
Open the Display Preferences in System Preferences via the Apple menu: System Preferences >
Displays. Then on the Arrangement tab make sure 'mirror displays' is turned off. Now you have two
separate displays on your computer.

Setup Resolume



Now start Resolume and check out the Output menu. The Fullscreen and Windowed options enable
you to select which of your computer displays the main Resolume output should go to.
For a straightforward single screen setup, Fullscreen is usually the option you want. Resolume will
fill the complete window with its output.

Windowed output just fills the second output with a rectangle exactly the size of your composition.
This is sometimes useful if you are using an external scan converter or are working with multiple
applications.

You can stop all output by selecting the Disabled option.

Tip! If you accidentally went fullscreen on the main window, you won't be able to access Resolume's
controls anymore. Don't worry! Just hit CTRL-SHIFT-D (CMD-SHIFT-D on a Mac) to disable all output and
get the interface back.

Advanced...
Hidden away in this tiny menu options is an amazing world of possibilities.

Composition output sharing
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Texture sharing (Syphon or Spout)
This will enable sending your main composition output via the Syphon framework on Mac, or the
Spout framework on PC.

Essentially, this will let you share the image created in Resolume to another application for further
processing. 

Read more about Syphon and Spout.

Network streaming (NewTek NDI)
This will enable sending your main composition output via the NewTek NDI protocol to other
computers on the same network.

Identify Displays
This will overlay your outputs with a numbered and coloured image. The numbers will match the
numbers your computer has assigned to those monitors.

3-1-2-8-9-11-10-5-6-7-4? Yes, I know those numbers don't match the order of the monitors on the table.
No matter which order I plug the cables, Windows seems to assign these numbers randomly. This just
proves how much we need a feature like this.

Open System Display Preferences
A quick shortcut to get to your computer's display settings. You know, for when those numbers



above somehow turned out wrong.

Show FPS
This will show a little FPS counter in the top left of the Output Monitor. This is an indication of how
far you're pushing Resolume.

Tip! Higher numbers are better. If this consistently drops below 25, it means you're pushing things too
hard.

Bonus Tip! Numbers higher than the refresh rate of your monitor are bad. It means you're not 'v-synced'
and you're making your computer do more work than it's actually able to show.

Show Test Card
Shows a handy little test card with color bars, the current resolution and time, and a moving
diagonal line.



Show Display Info
This will overlay each connected display with EDID information, which GPU it's connected to, and
which GPU is currently being used for rendering.

Tip! Don't worry if the GPU listed under 'Gfx Card' is not the most powerful card in your computer. This
just tells you which card you are physically plugged in to. The GPU listed under 'Renderer' is what matters
and this should be your most powerful card. 

Snapshot
This will save a .PNG still image of your output to your Recordings folder and import it to your
current composition.



Advanced Output
Using Resolume's Advanced Output, you can manage all sorts of outputs. You can use physical
outputs like a VGA cable connected to a projector, a DVI cable to a LED screen, a capture card like a
Blackmagic Intensity, a DMX signal sent to a pixel strip, or even virtual outputs like Syphon or Spout.

Multiple Outputs
If you are spanning your output over several projectors, or using a mix of different outputs like LED
screens, projector and pixel strips, Resolume provides a flexible way to control them all at the same
time.

Using the Advanced Output, you can choose which outputs you want to use. And you choose how
to use them by setting up which parts of your composition are sent to which output. This way you
can send VJ content to the main area, while displaying a single line-up still on the monitors in the
hall.

Projection Mapping
If you are doing a projection mapping show, you will use the Advanced Output to align your
projected content to the physical object you are projecting on. When using LED processors, you can
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scale and resize your output to exactly fit the needs of the processor. If you are using DMX
controlled lights, you can choose which fixtures you need to send to.

Basically, the Advanced Output is where the magic happens.

The Advanced Output is available on both Avenue and Arena. To get everything it has to offer, you
will need Arena.

For a quick start on how to use the Advanced Output with LED screens or for projection mapping,
check this chapter on creating input maps:

Working with Input Maps

If you want to know the nitty gritty of all the features of the Advanced Output, everything is covered
in the following chapters:

Screens
Input Selection
Output Transformation
Edge Blending
Saving and sharing Advanced Output presets
Key Modifiers and Shortcuts



Modifiers and Shortcuts
On both the Input Selection and Output Transformation stages, there are several shortcuts, key
modifiers and contextual menus to help you move and reshape your slices.

General Shorcuts
Ctrl-Z and Ctrl-Y (Cmd-Z and Cmd-Y on a Mac) undo and redo your last steps.

Key Modifiers
Hold down Shift while dragging to constrain movement to either the x or y axis.
Hold down Alt while dragging to make a duplicate.
Hold down Ctrl while dragging to temporarily disable snapping.
Hold down Shift while scaling slices to constrain aspect ratio.
Hold down Alt while scaling to scale from the center, rather than the opposite end.
Hold down Shift while rotating to constrain rotation to 45 degree angles.

Navigating the Stage
Ctrl-+ and Ctrl-- (Cmd-+ and Cmd-- on a Mac) zoom in and out.
Mouse scroll wheel zooms in and out.
Hold down spacebar while dragging to pan around the stage.

Nudging
Use the keyboard arrow keys to nudge 1 pixel at a time .
Hold down Shift while nudging to nudge 10 pixels at a time.

Slice Shortcuts
Duplicate with Ctrl-D (Cmd-D on a Mac).
When first using Alt-Drag to make a transformed copy, Ctrl-D will then duplicate and repeat



the transformation.
Backspace deletes the selected slice(s).

Mask and Polygon points
Double click anywhere on the path to add a point there.
Double click a point to delete.
Shift-click a point to add/remove it from the selection.

Contextual Menus
These differ per item, but generally will let you quickly access frequently used scalings and
positions.

Center X centers the slice on the x-axis.
Center Y centers the slice on the y-axis.
Mirror X places the slice exactly on the opposite side of the center x-axis.
Mirror Y places the slice exactly on the opposite side of the center y-axis.
Left half, Right half, Bottom half, Top half scale the slice to exactly that half.
Whole Area scales the slice to the whole stage. This is handy reset option for when you've
messed things up beyond repair.
Make Triangle creates a triangle shape that fills the entire stage.
Make Circle creates a circle shape that fills the entire stage.
Bring Forwards/Backwards moves the slice up or down in the slice stack. This is essentially
the same as dragging the slice around in the slice list on the left side.
Duplicate duplicates.

Match Input / Output Shape
These are so important and useful, we've singled them out for you. They will let the slice take the
position and shape that it has on the other stage. This way you can quickly match aspect ratios and
positioning on the Input Selection stage to the Output Transformation stage or vice versa.

Input/Output Guides
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a still image file in the background, to use a guide while lining up your slices.

It will load the file at its native resolution and position it in the top left of your screen.

You can adjust the opacity of the input map via the Opacity slider.

Loaded the wrong map to the wrong screen? Replace it via drag and dropping the right one, or
remove it with the 'X' button.

View Options

Show Slice Grid



This will show the outlines and a grid for the selected slice.

Show 8x8 LED Grid
This will divide the output up into 8x8 pixel lines. When snapping is enabled, your slices will then
snap to this grid. This is useful for making LED pixelmaps, since 99% of LED screens are made up of
blocks of 8 pixels. 

Show in Output
With this enabled, the Image Guides will show in the actual output.
This is very useful to double check if everything is aligned correctly.

Also, when Slice Grid is enabled, it will show both the grid as well as a red crosshairs on the actual
output, to help you get your bearings.



Input Selection



After setting up your outputs correctly, you can control how your content is distributed over these
outputs using the Input Selection.

The Input Selection stage shows a preview of your composition output.

On the left hand, it shows all active screens. You can read more about screens in the previous
chapter.

Slices
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Each screen can have one or more slices. To get your head around Input Selection and slices, think
of your composition as the pie and your slices as, well, slices of that pie. By defining a slice, you can
control what output will get which parts of your pie.
For instance, you can define that the left hand side of the composition will always go the projector
on output 1, and the right hand side should go to the projector on output 2. But you're not limited
to dividing it vertically, or even halfway. You can select any part of the composition you want to
account for different output resolutions and aspect ratios.

You are not limited to a single slice per screen. You can create as many slices as you like via the
plus+ menu. The sky is the limit.

Resizing, Moving and Rotating

https://resolume.com/manual/_detail/inputselection_03_screenswithslices.png?id=en%3Ar5%3Ainputselection
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When you open the Advanced Output, it always has one screen with one slice pre-made.

You select this slice by clicking it on the left hand side. You can then resize it and drag it around on
the Input Selection stage.

You can scale, position or rotate the slice simply by dragging. Rotating the input is very useful for
working with rotated LED panels.

Tip! Slices will snap to the stage edges, the center and to each other. You can temporarily disable
snapping by holding down CTRL.

You can also type precise numbers into the boxes at the right. This is useful if you need the output
to show a precise part of the composition. 

Tip! You can use math to let Resolume do calculations for you. Verrrry handy! Let's say you want to make
a slice exactly a third of its width, all you need to do is type â��/3â�� after the width setting and press
return.

Also you can nudge slices 1 pixel at a time by using the arrow keys. Hold down Shift when pressing
the keys to nudge them 10 pixels at a time.

Right clicking a slice, either in the list or on the stage, will reveal a drop down with some useful
presets and actions. Check the complete list on the Modifiers and Shortcuts page.

Tip! One interesting option is Match Output Shape. This will let the slice take the position and shape that
it has on the Output Transformation stage. This way you can quickly match the aspect ratio and
positioning for pixel perfect pixelmaps.

You can create as many slices as you like. You can duplicate an existing one or create new ones via
plus+ menu.

Also you can move slices between screens. Simply drag and drop them to the desired screen. Note
that a screen should always contain at least one slice, so Resolume will stop you when you try to
drag the last slice to another screen.

Slice Masks
Slice masks are available on Resolume Arena only!



Slice masks can be used to further narrow down the shape of your slice. For all its options, a regular
slice is limited to a rectangular shape. By using slice masks, you can define exactly which part of the
rectangle you want to see in your output.
To create a slice mask, click on any of the preset options on the right hand side of the Input
Selection screen. You can also click on the pencil to create a completely freeform mask. You can
invert a mask to make it a crop and vice versa. By toggling the Invert button on the right hand side,
you can either show everything inside the mask, or everything outside it.

After you have created the mask, you will notice two options in the top right of the Input Selection
stage: Transform and Edit Points.

Transform

In Transform mode, you can move the slice mask around like a regular slice. You have the same
options for scaling, positioning and rotating.

Be careful not to move the slice mask completely out of the slice, because this will result in empty
output. We know less is more, but that's maybe a bit too minimal.

Tip! When using a mask to create a specific shape for mapping, it helps to create your slice at the same
scale as the shape you intend to use. As opposed to cutting out a small part of a big slice. Resolume will
still warp the slice based on the corner points of the slice, not the corner points of the mask.
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Edit Points

In Edit Points mode, you can edit the individual points of the slice mask. You can move points
around by dragging or nudging them into position with the arrow keys. You can add points to the
shape by double clicking anywhere on its path. Double click on an existing point to remove it.

Here you can also switch the mask between linear and bezier. Linear draws exact straight lines
between the points, bezier lets you draw nicely curved lines. In bezier mode, the point handles will
be round. Each point will get two bezier handles, that you can use to curve the shape to your liking.

Using Polygon Slices
Polygon slices are available on Resolume Arena only!

If you want the ultimate control over the shape of your slice, poly slices are the way to go. Poly
slices will give you complete freedom on the shape and control points of your slice. Triangles,
hexagons, stars or complete freeform, it's all possible with a poly slice.
You create a poly slice via the plus+ menu. You can either create a preset triangle or draw a
freehand polygon by drawing it on the stage.

When drawing a poly slice directly on the stage, start by clicking where you would like your first
control point to be. Now keep clicking around your shape, placing a control point in every corner.
When you're done, just click on the start point or double click anywhere to close the shape.
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Once you have created your poly slice, Resolume will triangulate it for you. The same control points
that you have set in the Input Selection stage will be available in the Output Transformation stage
as well.

Keep in mind that it's possible to create a shape that's not 'triangulatable', for instance by creating a
shape that crosses its own path. In cases like this, Resolume will draw the outline in red. This is to
let you know what you're trying to do is mathematically impossible in this part of reality. For the
same reason, bezier points are not available on poly slices.

Transform Mode

After you have created your poly slice, you can still modify its scale, rotation and position in
Transform mode. In this mode, the poly slice behaves like a regular slice.

Edit Points Mode

In Edit Points mode, you can still add and remove individual points as well as change their position.
In this mode, the poly slice behaves like a mask.

Using Multi Select
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You can move, scale and rotate multiple slices at the same time.
Drag around a group of slices on the stage to lasso them together. You can also shift click individual
slices, either in the list or directly on the stage to add or remove them from the selection.

A bounding box will appear around your selection that you can drag, rotate or scale to your liking.
Also the properties on the right hand side are still available on the right side for precise numerical
input. Keep in mind that the numbers reflect the properties of the bounding box, not the individual
slices!
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Input Maps for LED screens
A LED processor usually takes a single video input (DVI/HDMI/VGA/composite) and divides this
signal over the connected LED walls.

Single LED screen
In the case of a single LED screen, setup is relatively simple. The processor takes the top left part of
the video signal and shows it on the LED wall. Let's say your LED wall is 384Ã�192 in resolution. The
output your processor expects would look something like this:

The processor will only take the top left part from a regular video signal. In this case the regular
video signal is 1024Ã�768, but it could be any standard video resolution. It's only interested in the
384Ã�192 pixels in the top left of that signal. The rest it throws away.

You could of course render all your content to this scale before show, but it's much easier to use
the Advanced Output.

Create a new setup, and on the Output Transformation stage, you make your single slice 384Ã�192
pixels in size and place it exactly in the top left of your output.
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Now switch over to the Input Selection stage, right click the Slice, and hit Match Output Shape. This
will place your slice exactly in the same place as it has on the Output Transformation stage. Drag it
back to the center, letting the snapping do the hard work for you. Now scale it up until it fills the
entire Input Selection stage again, Make sure you hold down both Shift and Alt to scale
proportionally from the center!
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What you have now is a slice that takes a 2Ã�1 piece of your composition and places it in the top
left of your output. This means that you will exactly see that part on your LED wall. By first matching
the output shape, you've made sure your input slice has the same aspect ratio as your output
shape. This means you probably lose a bit of the top and bottom of your composition, but your
circles will still look like circles and not squished eggs.

4 screen LED wall

Now imagine your stage is a bit more complex and looks like this:
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The annoying thing is that the 4 screens are positioned like that on the stage, but not in the LED
processor. In the LED processor, they might be arranged something like the image below. This is
done to minimize the data sent along the cable connecting the LED screens.

We've included a Photoshop mockup in the bottom right to help you get the idea of how the
processor relates to the stage.
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Tip! Keep in mind that 4 screens like this are still controlled by a single LED processor. So you only have to
send out one signal from your computer's output. The processor divides it over the 4 screens. Only on
very complex, high resolution LED stages will you need to use 2 or more processors and thus 2 or more
outputs.

First you recreate those four slices in the Output Transformation tab of Resolume's Advanced
Output. This way you send the processor the signal that it wants to see. If you're working with a LED
supplier who knows what they're doing, they can give you this 'output mapping' before show. All
you need to do is fill out the numbers that they provide and name the slices to keep things
organized.
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Then, on the input, lasso all four slices to select all of them. Then right click and choose Match
Output Shape. This will pop the 4 slices into the exact same position and scale they have on the
output stage.

Place the 'Center' slice exactly in the center of your comp. Place the other slices around it like they
are on the actual stage. Unless you want to break out the tape measure, this usually takes some
guesstimating and eyeballing. In the end it's about selling the illusion to the crowd, so it doesn't
matter if you're a few pixels off.

Tip! Depending on the stage, there's always a certain trade-off between correctness and pixel count.
When you're dealing with a few low pixel pitch LEDs combined with a lot of big crude lowres screens, a
perspective correct input map could require your comp to run at 4K or above, In those cases, it might be
a good idea to sacrifice a bit of correctness for the sake of still having a decent frame rate.

Once you're satisfied with the layout, lasso all the slices and scale everything up till it fills the canvas
again. Shift and Alt are your friends here!

https://resolume.com/manual/_detail/en/r5/inputmaps_moreled_02.png?id=en%3Ar5%3Aled_screens


Now whatever you play in your composition will translate perfectly to your LED wall. If you want a
DJ's name to only appear on the center wall, all you need is scale it down using the clip properties
till it fits.

Or even better, you can use the Slice Transform effect to place content directly in every slice you
want.

https://resolume.com/manual/_detail/en/r5/inputmaps_moreled_03.png?id=en%3Ar5%3Aled_screens
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Tip! If you're working with LED walls with mixed pixel pitch, you can scale the lower res tiles up more on
the Input Selection stage. This will keep their output resolution the same, while taking a larger area of
pixels as input. This way, the overall image on the stage will still look perspectively correct.

https://resolume.com/manual/_detail/en/r5/inputmaps_moreled_06.png?id=en%3Ar5%3Aled_screens


Output Transformation
The Output Transformation stage is available on Resolume Arena only!

The Output Transformation stage is where all the magic happens. You use it to align your output to
projection mapping structures or shuffle your pixels for output to a LED processor.

Transforming
The same screens and slices you've configured on the Input Selection stage are available on the
Output Transformation stage.

Just like on the Input Selection stage, on the Output Transformation stage you can change the size
and position of your slices. This is done in the Transform tab. In this tab, you change the position
and scale of your entire slice. The difference is that now you actually move the pixels around, as
opposed to choosing a different set of pixels to use as input.
This way, you can for instance take the bottom left quarter of your composition, and position it in
the top left of your output.

https://resolume.com/manual/_detail/en/r5/output_02.png?id=en%3Ar5%3Aoutputtransformation
https://resolume.com/manual/_detail/en/r5/output_01.png?id=en%3Ar5%3Aoutputtransformation


Warping

Additionally, on the Output Transformation stage you can apply screen warping, which means you
can adjust the geometry on the final output. This is useful for projection mapping the output to an
irregularly shaped surface, or when aligning multiple projectors for a spanned output.
This warping is done in the Edit Points tab. In this tab, you can adjust the individual points that
make up your slice.

There are several ways to warp.

Perspective Warping

You apply perspective warping by changing the four large corner points of your slice.

Perspective warping keeps the perspective of your output correct. For instance, when projecting at
an angle, the light hitting the furthest point of your surface will disperse further than the light
hitting the closest point. This means that your content will get more and more stretched the further
along your object it is. Using perspective warping, Resolume adjusts for this and keeps the scale of
your content correct along the length of your object.

https://resolume.com/manual/_detail/en/r5/output_03.png?id=en%3Ar5%3Aoutputtransformation
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Linear warping (left image) vs perspective warping (right image) when projecting on a cube at a 45
degree angle. Notice how the grid squares are evenly spaced on the right image, but stretched on
the left.

For most simple cube mapping work, perspective warping is the mode you want.

Perspective warping is available on regular slices only. Poly slices cannot be perspective warped.
Because of science.

Linear and Bezier Warping
Linear warping is applied by the four smaller corner points inside the perspective warper points.

These points work the same way as their bigger brothers, except they do not adjust for perspective.
They have the added advantage that you can add more points horizontally and vertically for more
complex warping.

https://resolume.com/manual/_detail/en/r5/output_linear.jpg?id=en%3Ar5%3Aoutputtransformation
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Also you can switch the mode from Linear to Bezier. Each point will then show two additional bezier
handles that you can use to make the warping curve like a Coca-Cola bottle.

https://resolume.com/manual/_detail/en/r5/output_05.png?id=en%3Ar5%3Aoutputtransformation
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Tip! Why choose when you can have both? Use the big corner points for perspective warping and their
baby brothers for additional bezier warping. This way you can have nice smooth curved mappings while
maintaining correct perspective.

Linear warping is also available on poly slices. Poly slices are super awesome because they can
change the position of each point of the mesh. Bezier warping is not available on poly slices.
Because of science.

https://resolume.com/manual/_detail/en/r5/output_08.png?id=en%3Ar5%3Aoutputtransformation


Masking
In the Output Transformation stage, you can also add masks. Masks allow you to hide parts of the
output, without distorting it. You can add as many masks as needed.

A mask will cut off all pixels that are outside of it. You can invert a mask, effectively creating a hole.

Tip! Nerd alert! The way we are most used to masking from for instance After Effects is actually wrong. In
After Effects, masks are actually crops, since they cut off the outside of the image. That's why by default, a
mask in Resolume is inverted. This way you get the behaviour you're used to, and we don't have to obsess
over the fact that it's actually technically incorrect terminology. Because that's the kind of stuff that keeps
us up at night.

https://resolume.com/manual/_detail/en/r5/output_09.png?id=en%3Ar5%3Aoutputtransformation


Masks and crops can have an arbitrary amount of points. By default you can choose from a number
of commonly used preset shapes, but you can make them into stars, the bat-signal, a tri-force or in
the shape of that weird stain on the wall in your attic.

Double click the outline to add a point at that location, double click a point to remove it. You can
make round corners by switching the Point Mode to Bezier.
Note that masks are applied to all the slices underneath it.

Slice Options
On the Output Transformation side, slices have some additional options.

https://resolume.com/manual/_detail/en/r5/output_10.png?id=en%3Ar5%3Aoutputtransformation
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Flips

Using the Pacman icons, you can flip a slice's output horizontally, vertically or both.
This way you can very easily make a mirrored setup by duplicating a slice, using the right click menu
to mirror it across the x-axis and then flipping it using the Pacman icon.

Color Correction

Each slice can have its brightness, contrast and red, green and blue channels adjusted. You can also
multiselect slices and adjust several of them at the same time.
This way you can adjust for differences between projectors when using a Matrox TripleHead2Go, or
to adjust the brightness levels for different LED panels connected on the same processor.

Is Key

Toggling Is Key will cause this slice to replace the alpha channel with luminance. It will send out
white wherever there are visible pixels and black where there is transparency.
This is useful to send an alpha channel on a separate output for overlaying graphics using a
broadcast mixer.

Black BG

Black BG is not a racially themed 70s cover band. Toggling it on will render your slice with a black
background, regardless of whether content is playing in it.
This is useful when you have a slice partially covering another slice, and you don't want to ever
reveal the parts of the slice underneath.

https://resolume.com/manual/_detail/en/r5/output_12.png?id=en%3Ar5%3Aoutputtransformation
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Slice Routing

Layer to slice routing is a very powerful tool. It allows you to create complex setups very easily. It
also has significant drawbacks, so use it with caution.

Routing Layers to Slices
Every individual layer of a Resolume composition is also available as an input for slices. 

By default, slices take the complete Resolume composition as input. You can assign which input is
used for a slice on the Input Source dropdown on the right hand side of the Input Selection stage.

After you have selected a layer as a direct input, you can warp and transform this layer directly,
completely separate from the composition.

This is for instance very useful when you want to display different content on 6 HD displays. In this
case, you can use layer to slice routing to keep your composition size down. You can keep your
comp size at 1920Ã�1080, and play each layer in its own slice. This way you don't have to render a
huge video containing your 6 videos in one. This is very efficient and doesn't place too much stress
on your computer and graphic card.

Ignore Opacity and Bypass/Solo
You can choose to bypass both the the layer's opacity and its
Solo and Bypass toggles. 

https://resolume.com/manual/_detail/en/r5/ass_avenue_layertoslice.png?id=en%3Ar5%3Alayertoslicerouting


This is useful if you want to see the layer only in this slice. Simply toggle off the Input Bypass/Solo
switch, and then bypass the layer in the composition. The layer will no longer render in the comp,
but it will stay visible in your slice.

Routing Groups to Slices
On Arena you can also create groups. 

Just like layers, groups can also be routed to a slice. You will have the same options to ignore the
Opacity and Bypass/Solo.

Routing the Preview to Slices
This is useful to get the Preview output in a separate external display.

Routing Screens to Slices
This is some serious slice-ception over here.

You can route the output of a Virtual Screen to a slice in another screen.

This way, you can add more phases to the warping process. For instance, you can edge blend two
physical outputs using the regular blending process. Then, you can let each of these two blended
slices take its input from a virtual screen. In this virtual screen you can then warp and map your
content to physical objects, without having to worry about the overall blend.

There's a few other useful scenarios, most of them get too complex to explain in a single paragraph
in a manual that no one reads.

When NOT to use slice routing
"When you have a hammer, not everything is a nail."

Keep in mind that by routing a layer to a slice, you actively decide to bypass the composition
completely. When a layer is routed to a slice, all layer and clip effects will still be applied, but blend
modes and composition effects will not! The slice will simply render all content with straight alpha
on top of the other slices.

Layer to slice routing can let you make setups very quickly, but you can also very quickly paint
yourself into a corner. It's best used to display layers of content on separate screens, when you are
sure you never want to mix them. 

Don't use it as a quick way to position content!

Let me repeat that, because I don't think you heard me. Don't. Use it. As a quick way. To position



content! You will not be a happy camper.

If that's what you want to do, use the Slice Transform effect instead. We have a whole chapter in
this manual dedicated on how you can create an input map for a complex stage design.



Edge Blending
Edge Blending is only available on Resolume Arena!

Edge blending is the dark art of stitching together the output of two or more overlapping projectors
and making one seamless screen out of them.

Resolume will help you do this by gradually fading out the area where the projectors overlap.

Overlap the Input
In order for edge blending to take effect, you need to have your slices partially cover the same area
of your composition. This overlap should mimic the physical overlap of the projectors on your
surface. In other words, you need to make sure that the slices overlap the same way as your
physical projectors do in the real physical world.

Tip! For best results, a minimum of 15% overlap is recommended.

https://resolume.com/manual/_detail/edgeblend_01_projectors.png?id=en%3Ar5%3Aedgeblending


You can use the test card ( Output > Show Test Card ) for this. Display your test card on the
projector and keep moving the slices towards each other until the image on the projectors shows
the same pixels in the overlapping area. The test card has numerical values on it to help you find
the correct spot on the grid.

https://resolume.com/manual/_detail/edgeblend_02_testcard.png?id=en%3Ar5%3Aedgeblending
https://resolume.com/manual/_detail/edgeblend_03_overlap.png?id=en%3Ar5%3Aedgeblending


Align the Output
On the output side, you need to make sure your projectors are aligned properly. The best way to do
this is to perspective warp each output while projecting the testcard again. Then keep adjusting the
corner points one by one until the grid aligns perfectly.

Tip! Perspective warping are the four big corner points of your slice. Make sure you use those and not
their smaller baby brothers that only do linear warping.

Blending
Then you can turn on edge blending for each slice in turn. Resolume will automatically blend the
edge in the middle. Magic!

https://resolume.com/manual/_detail/edgeblend_04_align.png?id=en%3Ar5%3Aedgeblending


Finetuning
You can still control the edge by refining the following three parameters:

Gamma Red, Green and Blue: This controls the overall brightness of the red, green and blue
channel of the softedge overlap area.

Power: This control the slope of the edge blend curve. The higher this number is, the steeper the
curve will be in the center of the fade area.

Luminance: This control the brightness of the centerpoint of your fade. This allows you to further
adjust the slope of the curve.

Gamma: This is the overall brightness of the fade area.

https://resolume.com/manual/_detail/edgeblend_05_result.png?id=en%3Ar5%3Aedgeblending
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Black Level and Brightness Compensation

Since projectors project light, they can never project true black (black actually is the absence of
light). Rather they project a very deep grey. So where two projectors overlap, this causes the
problem to double up. In the areas that should be 'blacked out' by softedging, they will project deep
grey on deep grey.
The result in the overlapping area will be an even lighter grey. The black level compensation is to
make up for this difference, by allowing you to make the non-overlapping areas slightly brighter.

Tip! Black Level Compensation is available on the output tab.

https://resolume.com/manual/_detail/edgeblend_07_blacklevel.png?id=en%3Ar5%3Aedgeblending


Screens
To start using the Advanced Output, select the Output > Advanced menu option.

You will see a window that lists the active screens on your computer down the left hand side.

Each screen represents an output going out of Resolume.

To setup a screen, right click on it on the left hand side. You
will see a dropdown of all outputs that are connected to
your computer. 

You can choose which output this screen should use. This way you can very quickly assign the
correct screen to the correct output when working with multiple outputs.

The screen will show the output it's sending to under its name, as well as in the Device dropdown
menu on the right. You can also change the name of a screen by double clicking on it.

Types of Outputs

Connected Outputs
Any monitors or projectors connected to your computer are automatically available as output for
screens. Resolume will show the name and resolution of this connection.

Keep in mind! Resolume itself does not create outputs. This is handled by your computer. So if you
have a screen connected to your computer, but it doesn't appear here, you will first need to make
sure your computer recognises it correctly. Check if it's set to proper extended desktop mode (PC)
and the arrangement is not set to mirrored (Mac). You can read all about setting up extended
displays in the chapter on setting up outputs.

Every output can only have a single screen associated with it. The poor projector would otherwise
get very confused when you try to send it two whole frames of pixels on every frame. When you
select an output already in use by another screen, Resolume will set the output of the other screen
back to virtual.

Tip! If you accidentally select the main monitor as your output, the output will fill the main monitor and



you won't be able to access the interface anymore. Don't worry! Just hit CTRL-SHIFT-D ( CMD-SHIFT-D on
Mac ) to disable all outputs and get the interface back.

Playback Cards
Any connected cards that support playback will show up here as
well.

Depending on the card, this will display various extra options that will let you select things like
which port and what video format to use.

Tip! For fluent playback, choose a Video Format where the update frequency matches both your content's
fps, your composition's fps and your display's refresh rate. Outputting at 50i will not give good results
when your monitor is refreshing at 60Hz, your content is 30 fps and your composition is rendering at 60
fps. Even when you're in Europe.

Also cards that have both an input and an output can be used for output. Keep in mind that not all
cards support full duplex. Full duplex is a fancy word for simultaneous input and output.

Output via playback cards is only available in Resolume Arena. It has support for playback via
Blackmagic, Datapath and AJA products.



Texture Sharing

Syphon/ Spout

Syphon (Mac) and Spout (PC) are protocols for texture sharing between applications. They will let
the output of one application magically appear as an input in another application running on the
same computer. Check out the Syphon/Spout chapter in the manual for more info on Syphon and
Spout



A
f
t
e
r
y
o
u
h
a
v
e
s
e
t
a

screen to output either via Spout or Syhpon, any Spout or Syhpon enabled applications will pick up
Resolume as a sender.

Resolume will use the name you give the screen as the Server Name / Sender Name. By default this
would be 'Screen 1'. You can change it to whatever you like. I would go with 'Charlie Screen'. This
screen has one speed: Go!

On the Mac, it will use either 'Avenue' or 'Arena' as the application name. On the PC, the application
is called either 'Resolume Avenue' or 'Resolume Arena'.

You can change the width and height of the screen to change the resolution of the texture you want
to share.

NewTek NDI

Similar to Syphon/Spout, NewTek NDI will let your share your output with other applications that
support the NDI protocol. The added advantage is that NDI works with multiple computers
connected to the same network.

You can use this to send a single output from VJ laptop to a master server computer, which is used
to scale and position the output to the pixelmap.

Virtual Outputs
Virtual Outputs are sort of an internal Syphon/Spout, just for Resolume. Screens set to virtual
outputs can be picked as input for slices in other screens.

This allows all sorts of complex scaling and routing possibilities, with a minimal performance hit.

You can change the output resolution of a Virtual Output by changing its width and height.



Adjustments

Adjusting Output Levels and Color

Each screen has Opacity, Brightness and Contrast controls, as well as individual controls for the
Red, Green and Blue channels. You can use these to adjust mismatched outputs. For instance, you
can dim the brightness on a LED panel while sending the undimmed output to a projector as well.
Or you can remove some red from a projector when it doesn't match the other projectors you are
using.

Adjusting Delay
Each screen can have a delay between 0 and 100 ms, to account for small delays introduced by the
signal chain after the outputs leave Resolume.

Hiding and Folding Screens
You can temporarily turn a screen off and on by clicking the toggle in front of it. This will enable or
disable all output to that screen. This is very useful when identifying which screen is which during
troubleshooting or to temporarily disable a single screen during performance.

You can also fold and unfold a screen by clicking the arrow beneath it. This will keep the output
going, while hiding all the slices contained in the screen. This is useful to prevent slices from getting
in the way when working with lots of screens and slices.

Preparing before show
You can prepare your screens without having them physically connected. This is useful when you
need to prepare for a show before the venue is open.

When you open the Advanced Output without having any secondary screens connected, it will open
with a single Virtual Screen. You can set the resolution of this Virtual Screen using the Width and
Height parameters on the right hand side.

https://resolume.com/manual/_detail/en/r5/ass_avenue_screencontrols.png?id=en%3Ar5%3Ascreens


By matching these settings to the resolution that your output will have during show, you can
prepare your setup beforehand. Then, once you are connected to the actual output, you can tell
your screen to use that output instead, via the right-click dropdown.

You can create as many Virtual Screens as you need via the Plus+ menu.



Keyboard and MIDI Shortcuts
Controlling Resolume with the mouse is great. You can access every parameter and set it with
precision. But during a live performance, you'll want to have more control than what the mouse can
offer. Sometimes, you want an exact thing to happen at an exact moment, without having to scroll
and search for it with the mouse. That's where shortcuts come in.

You use shortcuts to assign a button on your computer keyboard or MIDI controller to a control in
Resolume. Sort of like how CTRL-C and CTRL-V are shortcuts for copy-pasting. Except this time, you
get to decide what the shortcuts are.

Resolume supports external control via your computer keyboard, MIDI controllers and OSC
messages. If you're running Arena, you can also use DMX input from a lighting desk.

Assigning Keyboard Shortcuts
Let's start with a simple keyboard shortcut. We want the spacebar to be a blackout button. So when
we press spacebar, the whole output should go black. This is useful as a sort of panic button ("oh
no, get it off mah screen!"), or to create tension before a big drop.

You create shortcuts by opening the Shortcuts menu, and choosing
which protocol you want to create a shortcut for. So go to Shortcuts >
Edit Keyboard. The interface will now turn partially blue. 

You can also use CTRL-SHIFT-K as a shortcut to enter Shortcut mode. Shortcut-ception!

Toggle
Everything blue can have a shortcut assigned to it. So find the Composition
Bypass button in the top left of the interface and click on it with the mouse. Now
press the spacebar, and voila, you've assigned your first shortcut! If the Bypass
button was big enough, you could even read it had the spacebar assigned to it.

Press the Escape key to exit the Shortcut mode, and you can now bash that spacebar to toggle the
Composition Bypass on and off. On and off. On and off. On and off. Okay. Stop. That's enough.

Piano mode
Let's dig a little deeper.  Go back into Keyboard Shortcut mode, and select the Composition Bypass
again. In the bottom right of the interface, you'll see the Shortcuts tab. This tab is only visible while
you're in Shortcuts mode. In this tab, you can see all your keyboard shortcuts in a handy list.

You can also choose different options for your selected control.



The Composition Bypass is a very basic control,
it can either be on or off. Still, it has one option,
namely "Piano". All buttons in Resolume can be
set to Piano mode, which means that they will
be on for as long as you hold the key down,
and turn off when you release the key again. 

"But Resolume, that's not how a piano works at all!" Yes, you're right. Piano is easy to remember and
reminds you that you're playing an instrument. If you prefer, you can call this option Momentary or Flash
or whatever floats your boat.

Once you enable Piano mode for a shortcut, you also get the option to Invert.
This will let you turn the control OFF while the button is held, and ON when
released.

Range
You can get even further down the rabbit hole when you assign a button shortcut to a slider
parameter. Let's first set up a fun parameter to play with.

Put the Invert RGB effect on a clip. Leave all its parameters alone, but just change the effect's Blend
Mode to TimeSwitcher. You can now strobe the inverted clip, using the Opacity parameter to
control the rate. Pretty cool, right?
Now go into Shortcuts mode, and assign a shortcut to the Opacity of the Invert RGB effect. Let's go
with the ']' key.

You will see new options appear in the Shortcuts tab. The biggest one is a big slider called "Range".
You're now assigning a button shortcut to a slider, and a slider has more values than just on and
off. With the Range option, you can see what values the slider should jump to when the button is
pressed and released.



Let's set the values to 0 and 0.10. You can either drag the in and out point with the mouse, or click
the values and enter them numerically. After you exit Shortcut mode, you can now hit the ] key to
strobe the clip with 10% opacity and off again. Braaaaap!

In this mode, you also have the Piano option. Br-Br-Braaaap!

Value
Instead of just toggling, a button can also be used to set a slider
directly to a specific value. In the shortcuts panel, you can change the
Mode from Toggle to Value. Don't worry, we'll cover Mouse as well. Be
patient, young grasshopper.

In Value mode, you can use the keyboard to set a slider to a specific value. So pressing ] will set the
Opacity of the Invert RGB to 0.10, regardless of what it was set to before. This is great for resetting
a parameter to a certain value.

Multiple Shortcuts

Multiple shortcuts are especially awesome! You can assign more than one shortcut to a parameter.
Simply select the shortcut, right click it and select 'Duplicate Shortcut'.

You will see that ] is now used twice as a shortcut for rotation. By clicking one of them, it becomes
selected and you can change it to whatever you like, just by pressing a different key.

Let's go with [ and ] as the two keys. 



Now each shortcut key can have different settings. 

Let's set both keys to Toggle Mode, with Piano turned on. Set the range of '[' to 0 and 0.05. Set the
range of ']' to 0 and 0.1. Now you can strobe the invert effect at different rates using [ and ].
Because they're set to Piano and the minimum range for both keys is 0, releasing any key will
always turn the effect off.

Tip! If you're not that big on blinding your audience with epileptic strobing, you can also think of things
as using multiple keys to set the Hue of a Colorize effect to specific values. This way, you can quickly
match the color of the video to the color of the lights.

Shortcut Target
The Target option lets Resolume know which control you want to apply the shortcut to. There are
three modes:

By Position

This target just applies the shortcut to whatever order the clips or
layers are in. This is the default mode for shortcuts on the layer and
group panels. 

For instance, shortcuts for Layer Opacity default to By Position. Because you probably always want
your first fader on your MIDI controller to control the first layer in your composition, regardless of
how you re-order the layers afterwards.

This Clip, Layer or Group

This target applies the shortcut to this specific clip, layer or group,
regardless of where you move it. 

This way, you can assign a shortcut to always trigger a specific clip, like a color flash. It doesn't
matter whether that clip is in layer 1, column 1 or layer 27, column 95. It will always be triggered by
that specific shortcut.

Beware! When you delete that specific clip, layer or group, of course the shortcut disappears with it!



Selected Clip, Layer or Group

This target applies the shortcut to whatever clip, layer or group is
currently selected. This will always be the clip, layer or group that is
currently shown in its respective panel. This is the default target for
any shortcuts you apply on the clip panel.

A note on composition shortcuts and how sometimes Resolume 4 didn't make
a lot of sense.

Shortcuts assigned to composition controls or effects will never have a target. This is because there
is only one composition active at a time. This means it will always be the first composition in the list,
this specific composition and also the selected composition. 

Basically, it's every option at the same time. So why would we even have an option to change that?
Seriously. What were we even thinking?

Keyboard Specific Modes
There is one specific mode that is only available for keyboard shortcuts. It's called Mouse, and I
know that sounds weird, but it's pretty awesome.

Mouse Mode

In Mouse mode, you can use the mouse to control a parameter while you have the shortcut
pressed.

For instance, you can assign the P key to a clip's Position X. Switch to Mouse mode and set the
range to -960 and 960, or whatever your composition size is. 

When you now press the P key, horizontal mouse movements control the clip's horizontal position.

I bet you know where this is going now, right?

Assign the P key to Position Y also. Switch to Mouse mode, but now switch to Vertical. Set the range
to -540 and 540, assuming you have a 1920x1080 comp. 

Now holding the P key will give you full control of the clip's position. Releasing the P key will freeze
the clip where it is and let you use the mouse for pointing and clicking again.



Assigning MIDI Shortcuts
You can assign shortcuts for your MIDI controller in exactly the same way as you do for your
keyboard. 

The only difference is you need to let Resolume know you've got a
MIDI controller connected first. You do this via the MIDI tab of the
Preferences. If you like, you can read more about all the options you
can set via the Preferences.

For now, all you need to do here is toggle on MIDI Input and MIDI Output for the device you want to
use. That's it. We'll worry about the rest later.

Now, instead of entering Keyboard Shortcut mode, you enter MIDI Shortcut mode.

Then, just like with keyboard shortcuts, you select the parameter you want to assign a shortcut for
in the Resolume interface, and twiddle the knob, fader or button on your controller to set the
shortcut. Hit Escape and blammo. You've made a MIDI shortcut.

Every MIDI Message allows you to change its Channel and CC or Note values. If you know what
you're doing, you can use these to change the MIDI message associated with the shortcut. If you're
just assigning shortcuts for your controller, you don't have to worry about this.

https://resolume.com/support/preferences


MIDI Specific Modes
When you're assigning shortcuts for use with a MIDI controller, you get access to a few special
modes as well. Which modes are available depends on whether you're assigning a MIDI Note
message or a MIDI Control Change (CC) message.

MIDI CC Options
MIDI Control Change sounds very impressive, but it's basically just used for sending values between
0 and 127 from a fader or rotary knob. When assigning a MIDI CC shortcut, your options are
Absolute, Button, Relative and Fake Relative.

Absolute

Absolute is pretty straightforward. It just lets you control the range of the parameter with the range
of your fader or rotary knob. This is the mode you'll want to use on most standard MIDI controllers.

For instance, using Absolute mode, you can assign a MIDI fader to the Opacity of a layer. Pushing
the fader up makes the layer fully visible. Pushing the fader down makes the layer invisible. Yes, I'm
actually explaining this to you. I'm nothing if not thorough.

If you want, you can Invert this behaviour, or set a specific Range.

Button

Button is a bit weird. 

Some MIDI controllers, like for instance the Korg NanoKontrol series, can send out CCs when you
press a button. This makes very little sense from a logical perspective, but I'm sure they have their
reasons. 

Using Button mode, you can tell Resolume that this CC is actually being sent by a button. This way,
Resolume no longer thinks you're moving a fader, and you get access to all the cool button specific
modes like Toggle and Value.

Relative



Some rotary knobs don't send out fixed values
between 0 on their left side and 127 on their
right side. Instead of coming to a stop on each
end, you can twist them endlessly in both
directions, and they will keep sending out

different values. For instance, the APC40 MK1 has a relative rotary above the master fader. The
MK2 even has two, the second one is placed on the top right next to the Tap button.

This is very useful for setting parameters with a big range that you need to set precisely, like
Position X or Y, adjusting the BPM. You can also do fun things like scratching the playhead with
these type of knobs.

If your controller has a rotary like this, you'll want to use Relative mode for it. 

In Relative mode, you can change the responsiveness of the rotary by changing the amount of
Steps the rotary controls, or its Step Size for each turn of the knob. These controls are dependent
on each other, so changing one will update the other. Basically, a higher Step Size will mean fewer
Steps, and a bigger change in value when you turn the knob. A lower Step Size means more steps
and a smaller change in value.

Toggling on Loop will cause the parameter to loop back to the beginning when it reaches the end,
so you can keep on spinning forever. Also, you can Invert the shortcut.

Fake Relative

Fake Relative is not some shady figure claiming to be your uncle at parties. 

Some controllers have rotary knobs that you can spin endlessly, but that aren't actually relative
rotaries. Instead, they send out regular values between 0 at the far left and 127 on the far right and
you're supposed to use them like a regular, Absolute rotary. 

The first ReAct controller had these type of controls, and interestingly enough, also the APC40
series has them on both the MK2 and MK2.

Using Fake Relative, you can trick these rotaries into thinking that they're actual endless relative
rotaries, and you can use all the options you have for the regular Relative mode.

MIDI Note Options
MIDI Notes are messages that turn something On or Off. Their usually sent by the buttons or pads
of your MIDI controller. On some controllers, they can send 'velocity' values, based on how hard
you press the button.

Because MIDI Note are basically the same as your keyboard, you have the same options for Toggle,
Piano, Range and Value. Between these, you can cover most bases.

Velocity

One special mode is Velocity. If your controllers supports this, you will send velocity values when
you press the button. The harder you press, the higher the velocity will be. 



In Velocity mode, you can set the Range as well. This way, you can do fun stuff like changing the
scale of a clip by pressing a button. The harder you press, the bigger the clip will become, with a
maximum of 200%. When you release the button, it will drop back to 100%

MIDI Out Velocity

Do you like pretty colors on your MIDI controller? Of course you do.
So this is where the fun begins. A lof of modern MIDI controllers have
colored pads. By changing the velocity value you send to the
controller, you change the color of the pad.

Tip! We have lookup tables for most controllers, so you can select the color of the pad by picking a color,
instead of having to figure out what velocity is which color. On the APC40Mk2, we even have preview
swatches!





For a simple Toggle or Value shortcut, you can set which velocity to send for the Off and On states.

For Clip Trigger shortcuts, the party really gets started. As it turns out, a clip in Resolume can have a
whopping 5 states. So you can choose which color to send out for each state.

Group Shortcuts
Group shortcuts are shortcuts applied to a group of Radio Buttons, or to a Dropdown. Not sure
what Radio Buttons and Dropdowns are exactly? They're explained in detail, with examples, on the
Parameter page.

Shortcuts assigned to these type of control are special too. A regular control usually has only two
options, On or Off. These controls have a lot more. The Clip Direction controls have four options,
Forward, Backward, Pause and Random. The Layer Blend Modes have so many options I lost count.

When assigning shortcuts for these controls, you enter a whole new level of sophistication. This is
where you go from someone who mashes buttons to a distinguished shortcut connaisseur.

Direct

The most basic one is assigning a shortcut directly to a particular 'item'. Item sounds a bit strange
perhaps. It simply means you could for instance assign one key to play the clip forwards and
another key to play the clip backwards. 

You do this simply by selecting the buttons in the interface, and assigning a key to them. You will
see which state you have assigned in the Mode box.

https://resolume.com/support/parameters


The same way, you could also assign shortcuts for each Layer Blend Mode that you like, or for the
Auto Size options on the layer.

Piano

Piano is also available as an option when you assign a shortcut directly to an item. When Piano is
toggled on, pressing the shortcut will switch to that item, and releasing it, will switch it back to
whatever is was set to.

This way, you can quickly set the clip to random playback during an especially hectic part in the
music, and then release the button to go back to whatever direction it was playing at before.

Next/Previous/Random

It get a bit crazier by using the Select Next Item, Select Previous Item and Random Item options. By
selecting these, you can cycle through every item in that group of controls.

This way, you can for instance cycle through all the layer Blend Modes. You just keep on pressing
the same button until you land on one you like.

Cycling Specific Items

If you really want to get to the nitty gritty of shortcut control, try assigning the same shortcut to
more than one item in a group. 

For instance, assigning the same key to both play forwards and play backwards, will let you toggle
between these options with one button. Back and forth. Back and forth. Back and forth. If you really
want to go full control ninja, you can even use Piano in combination with this.

You can assign as many items to the same key as you like. Resolume will cycle to the next assigned
item on every key press.

Using CCs

You can also assign MIDI CC shortcuts to a group. This will let you cycle through every option in the
group. In most cases, this is not so very useful, but it can be fun to cycle through all the layer blends
with a rotary.

Tip! A super special secret group shortcut is hidden in front of
the clip triggers. It's revealed when you enter MIDI, OSC or DMX
shortcut mode. When you assign a shortcut to this, you can
trigger all the clips in that layer with a single control. For
instance, assigning a MIDI will let you trigger clip 1 through 128
by sending different values on that same CC. The same goes for

clips 1 through 255 on a single DMX Channel, or clips 1 through infinity on the same OSC address.



Shortcut Presets
You can save presets for every shortcut mode. This allows you to save and recall different layout
and shortcut assignment for different occasions. 

For instance, if you're a gear head and own every controller on the planet, you can have different
MIDI presets for each controller. A normal person could have have different layouts for the same
controller, so you can play different styles of shows with it. Or you could have a separate preset for
that one AV show you do with your musician buddy. The sky is pretty much the limit.

Every shortcut you assign is automatically saved into the current preset. You can switch presets via
the dropdown in the Shortcuts panel. Here you can also manage your presets via the New.../Save
as.../Remove and Rename... options at the bottom of the list.

Presets are simply XML files stored on your computer. So you can exchange presets between
computers, or share them with your VJ friends. Or share them with other Resolume users on our
forum.

Once selected, you will see a list of all assigned shortcuts for this preset.



This list contains each and every shortcut you currently have assigned, so it's very useful to
troubleshoot things. If you're a bit of a nerd, you can probably already see what a shortcut is
controlling, just by looking at its name.

By default, the list is organised per shortcut name. You can also sort it per key or MIDI message,
which makes it really easy to spot double assigned shortcuts. These will be marked in red.



You can delete a unwanted shortcut by hitting backspace or selecting Delete from the right-click
menu. Bad shortcut. Bad.



BPM
BPM is how weindicate the tempo of modern dance music. It stands for Beats Per Minute. A BPM of
120 means you have a beat every 0.5 second. Every musical genre has a typical BPM. Hiphop is
around 100, EDM is typically around 130, trance can go up to 140, while harder genres like
hardstyle and drumnbass like it at 160 and upwards.

Beats, Bars and Phrases
If this concept of BPM is really foreign to you, put on your favourite dance track. Wait for the part
where the beat kicks in. Now you'll hear this distinct pattern that the kick drum makes: dum-dum-
dum-dum-dum-dum-dum-dum. You're probably nodding your head along to it right now.

Every 'dum' that you hear is what we call a beat. Depending how fast the music is, you will have
more or less of these in a minute. Hence the name BPM or Beats Per Minute.

Now in dance music, every 4 beats make up a 'bar'. In turn, every 8 bars make up a 'phrase'. For a
more in-depth explanation of these concepts, check out the video below.

Okay, with that theory out of the way, let's get back to Resolume! Resolume makes it easy to sync
your content to the BPM that the DJ is currently playing. These BPM controls are so important to
VJ'ing, you can find them on the toolbar in the center of the interface.

Setting the BPM
There's a few ways you can set the BPM.

On the off-chance that you know exactly what BPM the DJ is playing at, you can set a BPM directly
by clicking the BPM value and typing it in.

Now let's say you don't know the DJ's tracklist by heart. In that case, by far the best way to get the
BPM is to just use your ears and tap along to the music. You do this by clicking the 'Tap' button a
few times to set the tempo. Tap the button in time with the beat. 1-2-3-4, 1-2-3-4. After you've done
this for a few beats, click the 'Resync' button on the first beat of the new phrase. When you press
'Resync', everything in Resolume that is set to BPM Sync will jump back to the first beat of the first
bar of the first phrase.

Now keep your eye on the blue square moving clockwise around the slightly bigger blue square. If
your BPM is on right on point, it should hit the top left corner on every first beat. To give you an
even better indication, this square will light up with a little outline every 16 beats, so you can check



if you're still in sync with the phrasing. 

When you find the blue square is arriving a little late, it means your BPM is set too slow. At first the
difference won't matter too much, but you'll get further and further out of sync as the song goes
on. You can fix it by increasing the BPM slightly by hitting the 'plus' button a few times. Of course,
you can hit the 'minus' when it's arriving early, or just tap out a new tempo if you're really, really
off. 

Now hit 'Resync' again on the first beat of the phrase, and see if it drifts again. Repeat till you get it
right. This is how DJs beat match records as well, and after a little practice, you'll be able to dial in
on the correct BPM very quickly.

If you don't like the hard cut you get from pressing 'Resync', you can also press the 'Nudge Up' and
'Nudge Down' buttons. These will temporarily speed the tempo up or down while you have the
button pressed, and set it back to where it was when you let go. This will let you catch up to the
music, or let the music catch up to you.

If you're playing a video only set, you can also send out a metronome to your headphones, so you
can beat-match your visuals using audio.

Later on we will see how we can use MIDI clock to synchronise the tempo in Resolume with another
program or piece of equipment.

Rhythm in Visuals
"But wait," I hear you yell, "what does all this rhythm stuff have to do with visuals? I'm a VJ, not a
DJ!"

Well, you're right. You don't necessarily have to beat-match all your visuals to be a good VJ. If you're
playing tunnel fly-throughs that don't really have a visible rhythm, you're fine with the basic speed
controls.  But if there's anything obviously rhythmical in your video, it makes sense to have that
match with what happens in the music. And one obvious way of doing that is beat-matching.

For instance, imagine you're playing a short walk-cycle animation of a big Mecha at a dubstep party.
If you hate dubstep and Mecha, that's cool. Just bear with me for a second and pretend you're one
of them annoying kids that need to get off your lawn.

Of course, it makes sense that every step of the Mecha coincides with a kick drum hit. When you
play the video like that, it will look as if the video was made for that track. This is why beat-matching
is such a powerful tool.

So first of all, make sure that every 'event' in your video happens in multiples of 2. So make the
robot take 4 steps, 8 steps, 16 steps, 32 steps etc. This way, Resolume will correctly guess the beats
for you when switching the clip playback to BPM Sync. Then all you need to do is keep the BPM in
sync, and all your videos will follow along.

The video linked here is actually a bad example. The robot takes 12 steps, which is great for getting rid of
its alcohol problem, but really bad for syncing. When you download that video, you should either set it to
play back in 12 beats, or trim it so it only takes 8 steps. Or better yet, don't download videos from

https://resolume.com/manual/en/r5/controlling#midi_clock


Youtube at all and learn to make your own awesome Mecha robot content, with exactly the right amount
of steps.

Of course, this doesn't just work for big Mecha's and dubstep. It also works with steampunk
machines pulsing and blowing steam on dark techno tracks, or strange alien creatures emitting
telepathic pulses from their third eye on goa trance music. It even works with abstract animation
on big room EDM. Rhythm is life, and life is rhythm.



Video
Resolume supports loads of movie formats. 

Can Resolume play my videos?
That's a simple question. The answer gets complex real quick, depending on how technical you
want to get.

Let's start with the simple answer: 

On Mac and Windows, Resolume supports 

.MOV files

.AVI files

.GIF files

.MP4 files.

.MPG and .MPEG files

So if your movie ends in one of those extensions, you're in good shape.

Of course, with computers things are never as easy as that. The file extension says a little, but not
everything about that file. It doesn't say anything about which 'codec' is used. And it turns out the
codec is actually the most important part about playing video.

So let's make it a bit more complex. 

If your system's video player can play it, so can Resolume. 

The rule of thumb is this: If your file opens and plays in Windows' Movies & TV app or Apple's
Quicktime X, it's going to play in Resolume. This means it supports most common codecs, like
h264.

If you need to use VLC or some weird codec pack to see your file, chances are Resolume can't play
your file. If Resolume can't play your file, it'll display it with a big yellow X in its preview.

Tip! If you have trouble playing a file, converting it to DXV is always, always, always the answer to your
problem. Need help with that? Read all about converting your content.

https://resolume.com/support/preparing-media
https://resolume.com/support/preparing-media


#Nerd alert!

Now if you're a bit technical minded, you probably want to know the nitty gritty about which codecs
are supported. If you're just here for playing cool videos and actually have a social life, skip ahead.

When Resolume opens a file, we first try to open it ourselves. When we see it's DXV or PhotoJPEG
encoded, we use our own player. This means you get hardware accelerated lightning fast playback
with DXV, and turbo fast playback on Photo-JPEG. Also GIFs are played back by our own engine.

If we don't recognise the format or codec, we pass it to the big boss, your computer's operating
system. On Windows, we ask MediaFoundation. On Mac, we ask AVFoundation. We ask them kindly
if they can play the file. If they can, we let them handle it for us and just display the frames we get
back. Letting the system handle things means you get some cool benefits like hardware accelerated
h264 on OSX.

If all that fails, we finally ask FFMPEG if they recognise what's going on and if they can make sense
of it. 

Unfortunately this doesn't mean that we support the full range of codecs that VLC supports. The
licensing for FFMPEG is actually very complex, and unless you're an open source product like VLC,
you are not allowed to just play all the codecs. When you stick to these rules, there are definite
limits to FFMPEG. And we like to play by the rules. Unlike other software that starts with a 'G' and
ends with 'randVJ'. There, I said it.

Playback
Resolume provides loads of ways to control how videos behave.

The Transport section of the Clip tab is where we can change the speed and direction that clips play
at.

Timeline

The first thing we will look at in the Transport section is the timeline itself. We can manipulate this
directly by grabbing the blue pointer that moves along it and sliding it around. This gives an effect
similar to DJ scratching.

The smaller bar below the timeline is also useful. Grab and move the small blue pointers at its end
to set the In and Out points of the clip. This is great for selecting parts of longer clips to use.



In the top right, you can see the current time of the clip. Clicking on this number will switch to show
you the remaining time.

You have direct control over the Speed of the clip. You simply use the Speed slider to speed the clip
up or slow it down.

BPM Sync
There is another very powerful way to control the speed of a clip. You can switch to it by the drop
down at the top right of the Transport section. It's called BPM Sync and it's awesome.

By switching the transport mode to BPM Sync, Resolume will use the global BPM to control the
speed of the clip. You can read all about BPM in its own chapter. For now, let's assume you have
Resolume running at the perfect BPM, perfectly in time with the DJ. Now all clips that have their
transport mode set to BPM Sync will play at a speed that synchronises them with that BPM.

In order for BPM Synced clips to work right, you will need to set the number of beats that the clip
spans in the Transport section. By default, Resolume will guess the right amount of beats for you
based on the length of the clip. It will guess to the nearest power of 2, so it will set the clip to 1, 2, 4,
8, 16, 32, 64, 128 etc beats for you. Of course, you can click the number and change it, use the + and
- buttons or use the *2 and /2 buttons to quickly multiply or divide the value by 2.

SMPTE
On Arena, videos can also be set to SMPTE. That rabbit hole is so deep, it's got its very own page.

Playback Options
The Transport section also provides some additional options:

Use these buttons to set the clip to play forwards or backwards, or pause the clip.
The Random button can be used to jump to random frames in your video. When in timeline mode,
the Speed slider now controls how often the clip will jump to a new frame. When in BPM sync
mode, the clip will randomly jump to a random beat and continue playing from there. Such
random. Much wow.

https://resolume.com/support/smpte


Use these buttons to control what happens when the clip reaches the end. 

The default mode is to loop, which will just start the clip from the beginning and continue playing
for ever and ever and ever. The second option is to ping pong, which means it plays alternately
forwards and backwards. Ping pong is a cheap way to avoid a visible cut on footage that doesn't
actually loop.

Next is play-once-and-eject. You can use this for 'one shot' samples that you want to drop into the
mix. The play-once-and-hold mode will hold the last frame of the clip when it's done playing, very
useful for stuff like logo reveals and DJ intros.

These buttons decide what happens when a clip is triggered. The first (default) option
plays the clip from the start. The second option, "pick-up", starts the clip from wherever
it was when it was last played. 

The third option, "relative pick-up", will start the clip at the same relative position the previously
played clip was at. I don't really know what you would use this playmode for. Bart really loves it
because Resolume 2 had it and he used it with crash test footage of different cars, and he could
change cars mid crash or something. I guess that must have been like pretty cool. Back in 2002.
Like, whatever.

BeatLoopr

When a video is set to 'BPM Sync', the BeatLoopr section is displayed. This enables you to have
Resolume automatically loop sections of the clip. This is great for adding climaxes, creating weird
vocal combinations or all kinds of other effects.

To use it, just select one of the options - the clip will loop over the relevant number of beats. When
you are done, just click the selected option again or the Off button. It's really that simple!

With 'Catch Up' active, turning the Beatloopr off will continue playback where the playhead would
have been if you hadn't used the Beatloopr. Otherwise, it will just continue wherever the playhead
was. 

Cue Points

https://resolume.com/manual/_detail/cuepoints.png?id=en%3Ar5%3Aclips


You can use the Cue Points section to quickly jump to any part of the clip that you like.

To set a cue point, click the smaller part to the left of one of the cue point buttons. The part you
click will turn blue and the letter on the main button will turn white - this means the cue point is
ready for use.

Now you can click the main button (or press the relevant keyboard key) to jump straight to the
point where you set the cue point.

If you want to set cue points precisely, a good way to do it is to pause the clip, drag the Transport
timeline marker to where you want the cue point and then set it.

You can reset an existing cue point in exactly the same way as setting it for the first time.

Tip! The Beatloopr will automatically turn off if you jump to a cue point. This way you can very easily
build a climax using the Beatloopr and Cue Points. During a climax moment in the music, simply keep
choosing shorter and shorter loops until the beat drops again, and then jump to the cue point you want
to resume normal playback at. Reach for the lasers!



Audio
Aside from moving and still images, Resolume can also play audio files.

Resolume supports playback of the following audio file extensions:

.WAV

.AIFF and AIF

.FLAC

.OGG

Also it can read the audio tracks in .MOV, .MP4 and .AVI files.

"Wait....What? No mp3s? Resolume, that's ridiculous." Yes, you're right. We're sorry. No mp3s.

But I'm a VJ, not a DJ!
I know, I know. Most of you are VJs, and you're thinking that you have no use for audio playback. 

Still, a lot can be said for being able to run an intro in full sync without the need for an extra
computer running QLab and complicated SMPTE setup.

Also, being able to play audio directly from Resolume opens up opportunities for super awesome
AV remixes. Hadouken!

Playback
When using audio, you have the same options for timeline and BPM Synced playback as on videos.
Also the Beatloopr and Cue Points work exactly the same.

Audio playback does give you one extra option. When in BPM Sync mode, besides the beats, you
can also set the BPM of the clip.

This option may be familiar to you from DJ software such as Traktor. By setting an audio file to a
BPM of for instance 130, Resolume will know the speed the file should be played back at. It will then
keep it sync with the master clock accordingly.

When first importing an audio file, you will see a red progress bar. This is Resolume analyzing the
audio file. When done, it will do an educated guess on the BPM of the clip. Based on that, it will also
do a suggestion on the amount of beats the clip should play back at.

Of course you can change this guesstimate to whatever you like. You're the boss.



AV clips
Of course, you can use audio files by themselves as stand alone content. When dragging an audio
clip to an empty slot, it will simply remain an audio file, and behave like any other clip.

But you can also use audio and video together by dragging an audio clip straight from the browser
onto a video clip, they will merge to become an audio-visual clip. 

The video will transpose to the length of the audio clip, so you get an exactly matched AV sample.

To merge audio and video clips after both have been added to the deck, hold down shift while
dragging the audio clip over the video clip.



Stills
Resolume can also play  still images. 

It can load and display:

.png files

.jpg and .jpeg files

.tiff, and .tif files

Once a still image is loaded, you get a few options for playback.

Transport

Just like a regular video, a still image can be played back in both Timeline and BPM Sync mode.
This changes what timing the still uses. In BPM Sync mode, it will use the global BPM. When set to
Timeline, it uses Resolume's own internal clock.

Aside from this obvious difference, it also changes how you set the Duration of the still image.

Duration
In Timeline mode, the Duration is set in milliseconds. 

Milliseconds is what programmers like to count in. To you and me, it means that you lose the last
three digits to get the value in seconds. So 1000 means 1 second, and 10000 means 10 seconds.
31415 means 31 seconds and a little bit.

You can use the + and - buttons to nudge it, or just type in a value directly. 

In BPM Sync mode, the Duration is set in beats.

You can use the + and - buttons to nudge up and down by 1 beat, use the /2 and *2 buttons to stick
to multiples, or just type in the exact number of beats directly.



Wait... What?
"Hold up, Resolume. Why are you going on about all this millis and beats and timeline and stuff? This is a
still image we're talking about. It has no duration! It can't go faster or slower, because it's not really
'going' in the first place."

Yes. You're right. When left to its own devices, stills are literally infinite, and changing their Duration
has no visible impact.

That all changes when you start using them with the Auto Pilot. In those cases, the Duration will
control how long it takes before the next Auto Pilot action is triggered.

Also, when you really get down to the nitty gritty details, this also affects parameters that are
animated to Clip Position. 

On Arena, you can even sync stills to SMPTE.

It's almost like stills actually have a sort of timeline after all.

Triggering Stills and Memory
Contrary to what you might think, playing back a still image is actually surprisingly resource
intensive. Although it's just a single frame, this frame has to be loaded into RAM in its entirety
before it can be displayed. This is for instance why Photoshop gets so slow when you're working on
a PSD containing lots of high res stills.

Because Resolume doesn't limit the amount of files you can load, it would be very dangerous to
load lots of high res still images. Dragging in a few megapixel TIFF files straight from your camera
would eat through your available RAM in no time.

This is why we do something called 'deferred loading'. This is a fancy term that basically means you
can load as many stills into a deck as you want. They will only use RAM at the moment you actually
trigger them. This benefit does come at a cost, namely that there can be a slight hickup when
triggering a still file. A few 1080p images is usually fine, but the hickup become more noticeable
when you start using 4K or above resolutions.

So if your VJ style depends on lightning fast triggering, it's best to avoid stills completely. Instead, it's
better to convert them to short DXV encoded movie files.

If you're using stills as part of a larger composition that doesn't rely on triggers, for instance as a DJ
name or a background image, it's perfectly fine to use stills. They're not quicker or slower than
regular movies.

More than Content
A great thing about stills is that they can also be used as masks or as guides in the Advanced
Output.

https://resolume.com/support/animation
https://resolume.com/support/preparing-media
https://resolume.com/support/masks




DMX
DMX Output is only available on Resolume Arena!

Resolume Arena can output the color or brightness of your pixels to LED strips or other light
fixtures via DMX.

This means you can play your videos on low resolution LED strips or other lights that support DMX
input. Make it part of your stage design and take charge of the lights as well as the video.

Using DMX Lumiverses

To do anything with DMX Fixures, first you will need to create a DMX Lumiverse.

https://resolume.com/manual/_detail/en/r5/dmxoutput_02.png?id=en%3Ar5%3Admx_output
https://resolume.com/manual/_detail/en/r5/dmxoutput_03.png?id=en%3Ar5%3Admx_output


A DMX Lumiverse is basically a DMX universe, except it only exists virtually, within Resolume. Like a
regular DMX universe, it consists of 512 channels. You use a Lumiverse to arrange and order your
fixtures.

This way, you can prepare your pixel map at home. When it's showtime, you can then quickly assign
a whole Lumiverse to the actual Art-Net node. Also, you can quickly change between different
nodes, without having to rebuild your pixel map from scratch.

Tip! Lumiverses are not a common DMX term. They're just used within Resolume to organise your output.
Don't use the word Lumiverse when talking to your LD buddy. He'll think you've been smoking the funny
baccy.

You create a Lumiverse simply by adding one via the + menu.

A Lumiverse has the same Opacity, Brightness, Contrast and Color options that a regular Screen
has. They behave the same way.
In addition, it has a Framerate and Delay setting.

Framerate

The framerate determines how often (per second) you send out the Lumiverse data. Higher values
make fixtures more responsive but are more performance intensive. You are sending more data
per second down the cable.

Delay

The delay determines the time between rendering the frame and outputting it to DMX (in
milliseconds). This is used to keep lights/projectors in sync. The default value of 120ms will give a
good result when matching lights and projectors. When using Resolume to control pixelstrips or
lights only, you can change this value to 0 for immediate output without delay.

Using DMX Fixtures
When you first create a DMX Lumiverse, it will create one default DMX fixture for you. The default
fixture contains 1 pixel of RGB data.

Unless you're controlling the sun via DMX, it's quite likely you'll need to use a different kind of light

https://resolume.com/manual/_detail/en/r5/lumiverse.png?id=en%3Ar5%3Admx_output


fixture than a single RGB pixel. You can select a different fixture preset by selecting the fixture and
using the drop down on the right hand side.

Tip! If your fixture is not in the list, don't worry. You can very easily and quickly create your own fixture
presets. You'll probably want to read the Fixture Editor page first.

Let's say that you have a set of three LED tubes. Each tube has 16 RGB lights and they're arranged
in a triangular shape on the centre of the stage.

Select the Fixture
The first thing to do is to change the default fixture to the corresponding entry from the list.

You'll notice that the fixture name has changed. Also the Input Selection area of the fixture has
become 16 times as wide. This is because you can now assign colours for 16 pixels, instead of only
1.

Position the Fixture
You can move, scale and rotate the input of this fixture to match the physical location of the light in
your stage design. Let's make it 800x50 pixels. Assign its input to the bottom centre of the
composition by placing it in the bottom centre of the Input Selection window. Resolume will sample
the very centre pixel of each square as input for the RGB channel. You'll see exactly which colours
itâ��s sending in the preview on the bottom of the slice info.

Tip! Of course changing the input size in pixels doesn't change the size of the LED tube. Also the location
in the composition doesn't change anything to its physical location. But it makes sense that you need to
match the input size and position of your other stage elements, such as projection surfaces or LED wall
tiles. This will create a matching picture on all your screens and lights when you start playing video on
them.

More Fixtures!
Create another DMX fixture via the big + drop down menu. Youâ��ll notice that this new fixture is
also a 16 pixel LED bar. Resolume will take the previously used fixture as the default for newly
created DMX fixtures.

Make this fixture the same width and height as the previous one, but rotate it to -60 degrees. Place
it so that it makes the left leg of a perpendicular triangle.

Create the third fixture by duplicating the second fixture. You do this by right clicking on the fixture,
either in the list on the left or in the Input Selection canvas itself. Rotate it to 60 degrees, and use it
to finish off the triangle.

Tip! Use the scroll wheel or CTRL + and - ( CMD + and - on a Mac ) to zoom in and precisely position your
fixture slice. You can use the pan tool or hold down spacebar to pan the canvas.



Sending DMX to your LED lights
After setting up all your inputs, it's time to actually send out some output to your LED tubes.

Right-click on your DMX Lumiverse. Just like with
Screens, Resolume will show a list of the detected Art-
Net nodes on your network.

Simply select the name of the node you want to use and Resolume will fill out the complicated parts
like IP addresses and universes for you.

Tip! If your device doesn't show up in the list, make sure the IP of the device and the computer running
Resolume are in the same IP range and are using the same subnet mask.

https://resolume.com/manual/_detail/en/r5/dmxoutput_04.png?id=en%3Ar5%3Admx_output


Picking the right Network Interface
It could be that your computer has both a wired and wireless network interface. If your Art-Net
nodes are on your wired network, but Resolume is looking on the wifi, it won't be able to find
anything.

You can make sure Resolume is looking on the right network via the DMX tab of the Preferences.

Using a manual IP
It could be that you're using some sort of homebrew Art-Net device, like an Arduino. In that case, it
probably won't show up in the node list, but you will be able to send Art-Net to it. On the right hand
side, choose IP Address from the Target IP dropdown. You can then fill out the IP manually. 

Remember that in this case, you will need to set the Universe and Subnet manually as well. For
most devices, Universe 0 on Subnet 0 is the default setting for the first port.

When sending Art-Net to a specific named node, Resolume will remember that node's name, and
keep sending to it, even if its IP address changes. When sending to a specific IP address, Resolume
will keep sending to that IP, even if the device changes or if there's nothing there anymore.

Using Broadcast
Instead of sending to a specific node, you can also broadcast DMX to all the devices on your
network. 

If sending to a single node is like addressing a request to a person by name ("Hey Bob, could you
take out the trash please?"), broadcasting is the same as shouting really loud and hoping that
someone will listen ("SOMEONE NEEDS TO TAKE OUT THE TRASH! LIKE, NOW!").

When broadcasting, there is no need to set the IP, but you will need to set your Subnet and
Universe accordingly.

When you start hitting 30 universes or more, it's a good idea to stop using broadcast and using
gigabit switches and unicast instead.

A word on DMX USB devices
Resolume Arena 6 does not support Enttec DMX USB devices. If you'd like to use an Enttec
DMX USB device, you're only option is to stick with Arena 5.

Because USB boxes are limited to one or two universes, Resolume only supports Art-Net based
solution. Showjockey and several other companies have boxes to get up to 8 or even 16 universes

http://www.showjockey.com/


of DMX over a single Art-Net connection. If you're not afraid of some DIY there are also plenty of
cheap alternatives.

Patching your Lumiverse

Switch back to the Screen Setup, select your Lumiverse and switch over to the DMX Output tab. The
DMX Output is the overview of how your fixtures are arranged in your Lumiverse. You'll see that the
first fixture takes up 48 channels. This makes sense, as it has 16 pixels, each with a R, G and B value
( 16 * 3 = 48 ! ).
The second fixture starts at channel 49, right after the first one finishes. The third fixture starts at
97. These Start Channels should correspond to how your dip switches are set up on your LED
tubes. This way Resolume knows which set of pixels need to be sent to which tube.

Tip! You know there's 10 kinds of people in the world. For those of you that can't count in binary, you can

http://nutcracker123.com/nutcracker/rgb_controllers/
https://resolume.com/manual/_detail/en/r5/dmxoutput_06.png?id=en%3Ar5%3Admx_output
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see how your dip switches should be set up visually in the bottom of the fixture info tab. 
If your LED tubes are set up differently, you can simply drag the fixtures around in the DMX Output
window. Youâ��ll notice the Start Channel and the dip switches update themselves accordingly. If
you prefer, you can adjust your dip switches directly or just type in the Start Channel. Your fixtures
will then arrange themselves in your Lumiverse. Just make sure the channels do not overlap,
otherwise you might get weird results. Resolume will warn you when this happens, by marking the
overlapping channels with red.

After you have set up the correct start addresses, your LED tubes should correspond to what you're
playing on them. If one or more tubes were placed upside down or the wrong way round, you can
use the Pacman icons to flip their output. Also you can adjust their brightness and contrast should
that be necessary.

Aligning your output
To check whether your outputs line up correctly, you can use the Test Card from the Output menu. 

The test card has a diagonal line moving across the screen, so youâ��ll quickly notice if your LED
tubes are somehow placed different in the physical world, than how you placed them in the Input
Selection tab. 

If something is wrong, first make sure the Start Channels match up using the DMX Output tab. Also,
it might be necessary to use Pacman to flip the output horizontally and/or vertically before its sent
to the fixture.



Fixture Editor

When your specific type of fixture does not appear in the list, you can create one yourself. You do
this by clicking the gear icon next to the Fixture selection drop down.
This will open the Fixture Editor. You can create a new fixture, adjust an existing fixture or duplicate
an existing fixture and go from there.

Creating a New Fixture
Let's start by creating our own personality from scratch by hitting the plus icon on the bottom. This
creates a default 1 RGB pixel fixture called New Fixture. 

The first thing you'll want to do is change the name to something that makes sense to you. The
manufacturer name and the amount of pixels are usually a good convention.

Note that if you update an existing fixture, and this fixture is already being used on the Input
Selection stage, you will update all instances of the existing fixture as well. If you want to make
changes without affecting the current setup, make a duplicate of the fixture preset first.

Setting up Parameters

https://resolume.com/manual/_detail/en/r5/fixtureeditor_01.png?id=en%3Ar5%3Afixture_editor


Then you can set up the parameters. If you're dealing with a basic LED tube or tile, you can just
assign the amount of pixels you need vertically and horizontally. On the right you will see a preview
of how your fixture is arranged.
So a 16 pixel LED strip would have a width of 16 and a heigh of 1. A square LED tile with 64 pixels
would have a width of 8 and a height of also 8.

Dummy channels
Depending on the type of fixture, it could be that certain channels are reserved for specific features
of that light. For instance it could be that the first channel switches between different chase
presets. You see this often in off-the-shelf LED tiles. Your light will have info about this in its user
manual.

In these cases, you can create extra parameters by clicking on the + icon in the bottom of the
Parameters tab. You can re-arrange their order by dragging them up or down, using the three bar
handle on the right of the parameter, similar to how you drag effects up and down in Resolume's
effects tab. 

This way your light will get the correct pixel data at the correct channels, without having to offset
the Start Channel. 

Tip! Sending nothing is not a concept that exists in DMX. When you assign a channel, the DMX protocol
expects you to always send a value on that channel. So Resolume will send the value you set as Default.
So if you are adding a Dimmer channel to a fixture, you'll want to set the Default to 255.

For ease of use, you can of course rename these parameters as well.

https://resolume.com/manual/_detail/en/r5/fixtureeditor_02.png?id=en%3Ar5%3Afixture_editor


Channel Distribution

Now is also a good time to adjust your distribution if necessary. Your distribution refers to how
your pixels 'snake' through your fixture. Some fixtures start at the top left, and then keep going left
to right, like you would read a page of a book. 
Other fixtures start top left and zigzag back and forth on their way down. You can come across
pretty much every variation of this, which are all covered with the 16 distribution options. When
you change your distribution, youâ��ll also see the channel layout change in the preview.

Choosing a Color Space

Then you can choose the colour space you want to use with your fixture.
Full colour LEDs create colour using separate values for red, green and blue. Depending on the
strip, either separate red, green and blue LEDs or a single full colour LED are used for each pixel.
Selecting RGB (or one of its variations) assigns 3 channels for each LED in your strip.

Mono coloured LEDs use the weighted luminance value of the sampled pixel. Selecting L will send
this luminance value over a single channel for each LED in your strip.

Some lights prefer to work with CMY values instead of RGB. Here Resolume does a regular 1:1
conversion from the pixel's RGB values to the CMY color space.

Resolume also supports less common varieties such as RGBW and RGBWA. We approximate the
color on the extra white and /or amber LEDs by dimming the other channels and sending out on
this channel instead.

https://resolume.com/manual/_detail/en/r5/fixtureeditor_03.png?id=en%3Ar5%3Afixture_editor
https://resolume.com/manual/_detail/en/r5/fixtureeditor_04.png?id=en%3Ar5%3Afixture_editor


Setting up Gamma Correction
If you're dealing with an unusual type of LED, you can tweak the Gamma Correction of the LEDs.
Most of the time the default setting of 2.5 should be fine.



Syphon, Spout and NDI
Syphon (Mac), Spout (PC) and NDI (both Mac and PC) are great tools to route the visual output of
one program to another. 

Syphon and Spout work on the same computer. The output of one application can be picked up by
another. This wayt, you can for instance get jiggy with your funky Processing sketches, but apply
effects and map them to a surface with Resolume Arena.

NDI works over the network. So you can send the output of Resolume running on one computer to
Resolume running on a different computer, without the need for extra hardware. Just a regular
network connection will work.

Using NDI, you can send video from a Mac to a PC and vice versa, no problem.

Input
Syphon, Spout and NDI input are always
enabled in Resolume.

Any program that is sending its output will show up under the sources tab. You can add them to a
deck like you would any other live input.

You can use as many inputs at the same time as you want.

https://resolume.com/manual/_detail/syphon.png?id=en%3Ar5%3Asyphon


Output

The moment Syphon, Spout and/or NDIis enabled via the Output Menu, Resolume will immediately
start broadcasting its main output as well.
Other Syphon/Spout enabled applications running on this computer will now pick up Resolume's
composition output.

Computers on the same network will now pick up Resolume's composition output via NDI.

For applications that do not auto-detect broadcasting Syphon/Spout servers, Resolume's main
output identifies itself to as follows:

App Name: â��Avenueâ�� or â��Arenaâ��.

Server Name: â��Compositionâ�� (for the main composition output) or â��Screen 1â�� (when
using the Advanced Output to route a screen).

Advanced Output

https://resolume.com/manual/_detail/en/r5/syphon_02.png?id=en%3Ar5%3Asyphon


Resolume Arena allows you to further control this
via the Advanced Output. Syphon, Spout and NDI
outputs can be treated like a separate physical
screen. 

This allows you to warp the output before sending it, or to select parts of your composition to send.
While you can still send a different output to your physical screens.

When sending to Syphon/Spout you can change the width and the height of the output as desired.

Syphon Example Code
Example code for Processing:

For Arena:

client = new SyphonClient(this, "Arena", "Composition");

Or for Avenue:

client = new SyphonClient(this, "Avenue", "Composition");

If you use a Syphon output via the Advanced Output of Arena, you can name the server yourself:

client = new SyphonClient(this, "Arena", "Screen 1");



Registering
The download of Resolume will work in demo mode straight away. You will notice that occasionally
the Resolume logo will appear on the video output and a robotic voice will remind you what
software you are using. 

This is the only limitation of the demo. You can use every feature and try all the things Resolume
has to offer.

In order to get out of demo mode and use Resolume for real, you can buy a license from our
webshop. When you have done that, you will receive a serial number.

Once you have a serial number, select File > Preferences in Resolume and click the Registration tab.
Enter your serial number into the text box and click 'Register'. 

Resolume will now use your Internet connection to confirm your serial number. Once this is
completed, Resolume will be fully registered. The audio and video reminders will be gone.

http://www.resolume.com/shop/
http://www.resolume.com/shop/


Resolume will occasionally need to check if everything is still in order. It does this automatically
every time you run Resolume on a computer with a working Internet connection. You won't even
notice it. If you run Resolume on an offline computer, it will remind you to phone home once every
30 days.



Offline Registration
You can register Resolume without having an Internet connection on the machine you install it on.

To do this, select File > Preferences in Resolume and click the Registration tab. Then click the Offline
Registration button. Take a note of the ID Code that is shown. You will now need to use a computer
that does have an Internet connection to visit: www.resolume.com/register

You will need to enter your serial number and the ID Code that you just noted. The Resolume
website will then generate a registration key file. Transfer this file to the computer that you have
installed Resolume on.

Now select File > Preferences in Resolume and click the Registration tab. Click the 'Offline
Registration...' button and then the 'Load registration file...' button. Select the file and Resolume will
become fully registered.

Unregister
When you need to re-install your operating system or when you have bought a new computer,
make sure you remove your registration. To remove your Resolume registration from a computer,
go to the Register tab in the Preferences and click on the "Unregister" button. This will remove your
serial number from the computer.

Sometimes computers get stolen or damaged. Also, we're all humans and sometimes we tend to
forget things. 

In short, stuff happens. 

When stuff happens, don't worry. You can still use Resolume. Just log in to your account in the shop
to remove your Resolume license from the lost computer, and you'll be good to go.

http://www.resolume.com/register
https://resolume.com/shop/account.php


One License, Many Machines
A multi-seat license will come with a single serial. This serial can be used to have more computers
registered at the same time. So a Resolume license for 3 computers will come with a single serial.
That serial can then be used to keep  3 computers registered simultaneously.

Similarly, when upgrading from Resolume for 1 computers to 2 or more, your serial number will be
'expanded' to be valid on 2 or more computers. It is not possible to split the license into several
serial numbers.

+ 1 Backup
Every Resolume 6 license gets one additional backup. 

You can use that backup how you see fit. You can use it to always have two computers registered as
a fully redundant system. Or you can use it to register both your home studio render beast and and
use the backup for your live laptop. Or you can keep your second install unused and ready to go
when your first computer catches fire.  Whatever you prefer.

The ever important small print: when upgrading to a multi-seat license, you still get 1 backup. So if
you have Resolume for 2 computers, you can install it on 2 computers + 1 backup. Then on to 3
computers + 1 backup. Then 4 computers + 1 backup. Etc etc. You see where this is going. We all
watched Sesame Street when we were kids, so you know how Count Count counts. 

The backup is there to tie you over in case of emergency. If your shows are that important that you
need full redundancy, for all your machines, all the time, we kindly ask you to purchase a license for



the required amount of computers.



Tech Specs

Minimum Specs

Windows

Windows 7 SP 1 or later, 64 bit
AMD or Nvidia graphics card with 256MB of VRAM
4GB RAM

Mac

OS X 10.9 or later
AMD, Nvidia or Iris Pro graphics card with 256MB of VRAM
4GB RAM

Recommended Specs

Windows

Windows 10 
i7 Processor, 2.5 GHz
Nvidia GTX 1080
M2 SSD
16 GB Ram

Mac

OSX Sierra
i7 Processor, 2.5 GHz
Radeon Pro 450
SSD
16 GB Ram


